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Dear Customer,

ARCHOS thanks you for your choice of this exciting AV400 product. Never
before has one been able to carry with him or her so much information, be
it MP3 digital music, MPEG-4 digital videos or digital photos, and be able
to enjoy these without a computer. We are sure that your AV400 will give
you years of listening and viewing enjoyment. Of course you can always
use it as a regular portable hard disk too.

This guide will explain to you the functions of the Av400. Our engineers
have packed this product with many functions and capabilities. The
better you know how to use it, the more enjoyment you will get from it.
Remember, with the AV400, you can...

¢ Play MPEG4 video files on the built-in screen, a television or video projector
¢ Record and edit MPEG-4 video files from a television or other video device
¢ View JPEG and BMP images and slide shows

¢ Listen to MP3, WMA, or WAV music files

¢ Record music files into digital format directly from your hi-fi without a computer
e Use it as a voice recorder

e Store .DOC, .TXT, or any type of data file — it's a portable hard drive too!
¢ Create music Playlists

e Copy Pictures or data from CompactFlash™ cards directly to the AvV400

We wish you many years of enjoyment from your AV400 product. Please do
register your product at our website www.archos.com/register/products.
html to ensure that you get access to our help line and to be informed of
free software updates for your product.

Wishing you the best Video, Music, and Photo experience,

The ARCHOS TEAM
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INTRO - Ports, Buttons and Connections
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Hard disk activity indicator (red)

On indicator (green)

Battery charger indicator (green)

Move UP (also increases volume during media playback)
Move DOWN (also decreases volume during media playback)

Move LEFT (also plays previous song or fast reverse through song or video)
Move RIGHT (also plays next song or fast forward through song or video)

On/Enter/Play/Go @ — Hold for 4 seconds to turn on

Escape/Stop/Off ¥ — Hold for 4 seconds to turn off device

Left function button — Activates the left on-screen menu item (p)

Also buttons lock.

Center function button — Activates the center on-screen menu item (q)
Also speaker on/off

Right function button — Activates the right on-screen menu item (r)

LCD/TV button — Hold down for 3 seconds to switch between LCD and
external TV display

TFT LCD screen 320 x 240 pixels

Built-in loud speaker (hold down on button k for three seconds to turn
speaker on and off)

Screen function buttons which correspond to j, k, |


www.archos.com/register/products

INTRO - First Time Usage

Please take the time to read though this manual. There are many
things that this device can do that you may not be aware of.

a LCD/TV button — Hold down for 3 seconds to switch between LCD and

external TV display 2.1 Plugging in the AC Adapter
b  Microphone — for making digital voice recordings
€ CompactFlash™ Type I slot e Use only the included ARCHOS charger/adapter.

o Before using for the first time, charge the batteries for a full four hours.
e You may use the Archos Video AV400 while its battery is charging, but
it will then take longer before the battery is completely charged.

2.2 Turning on the AV400

e Hold the PLAY/ON button O for 4 seconds. The green “On”
indicator light will turn on. Be patient, it will take about 8 seconds for the
operating system to boot up.

o If the unit shuts off after holding the ON button for several seconds, plug
in the Archos adapter/charger to make sure the batteries get charged.

2.3  Shutting off the AV400 and Battery saving features

a USB 2.0 port (USB 1.1 compatible) to connect the AV400 to your computer To shut off the unit, press and hold the STOP/ESC/OFF button %

b  Power Connector (use only the supplied Archos power charger/adapter) for 3 seconds. oo

C  Multi-connect jack* — for headphones, TV Cradle, and AV in/out connections In the Power menu [Setup -»Power: Battery Operation] ]
there is a Power Off parameter. It is factory set to 2  Setup

*The optional multi-connect adapter and AV cable allow for audio and video minutes. Thus, if your AV400 is idle for 2 minutes, it will shut *

layi di ithout the TV Cradle. - Ny ! .

playing/recording without the radie off. This setting can be changed from one to nine minutes g
or to ‘never’. w\yé
In the Power menu [Setup —Power: Battery Operation] Pu'-:.-';;r

there is a Backlight Off parameter to save battery power
(the lighting of the screen consumes a lot of the battery
power). It is factory set to 30 seconds. That is, if there are no buttons
pressed, the screen will shut off in order to save battery life. To turn the

screen back on, just click once on any button. See section 17.5 for a
Multi-connect Adapter AV Cable complete explanation.

-1




Changing the Language

The AV400 interface can be set to English (default), French, or German.

[

e To change the language, move the joystick to Setup and E}E—
then click PLAY/ENTER ©. Setup

e Then move with the joystick to Display and click PLAY/ENTER ©.

e Using the joystick to highlight the Language parameter. 4

e Now move the joystick to the Right or Left to choose the I""’:l}

desired language. o
e Choose French, German, or English.
e The language displayed will change immediately. J'
e (lick on the STOP/ESC button % to _ _ _
exit this screen. s L Gae D

Display

Foreign Character Sets

You have the possibility to display your file names, folder names, and
MP3 ID3 tags in various character sets (ex: Korean, Japanese, Simplified
Chinese, etc.). You can find the language files CodePage_name.4FZ in the
font folder under /Data on the AV400 hard disk or on the Archos website
under the heading Software. If, for example, you would like to have the
Korean language display, then you would copy the file CP949.4FZ into the
folder /system on the AV400 and shut down and restart the AV400. File
names, folder names, and ID3 tags written using the Microsoft® codepage
for the language will now be displayed in that character set. Only one
.4FZ can be used at a time, thus you should only put one .AFZ file into the
/system folder. When an .4FZ language file is used, the interface language
will be set to English.

Charging the Batteries

Use ONLY an Archos charger/adapter that is specified for the AvV400.
Other chargers or adapters may damage the AvV400. The green CHARGE
indicator lights up to indicate that the external adapter is connected.
The batteries will charge automatically when the AC adapter/charger
is plugged in. Once the batteries are fully charged, this light will blink,
indicating that you can disconnect the charger/adapter. Once charged,
you can get up to 12 hours* of MP3 music playback time and up to

4 hours* of AVI video playback time (on the built-in screen) from the
batteries. Some AV400 models are made with integrated batteries which
are designed to last for the life of the AV400. This means that you will
not have to change them. If, in the exceptional case, the batteries need
changing, this should only be done by an Archos technician.

* depending on how you use it (start/stop/writing, etc.)

Caring for the Av400

The Archos Video AV400 is an electronic product that needs to be treated
with more care than typical consumer electronic products.

¢ Do not subject it to shock.

¢ Do not subject it to heat. Keep it ventilated (especially when connected
to a computer).

o Keep the AV400 away from water and excessively humid areas.

e Keep the AV400 away from high electromagnetic fields.

e Keep any connected cords to the AV400 neatly arranged. This light
product could fall if a cord is accidentally pulled by a child.

e Do not open up the AV400. There are no user serviceable parts inside.
Opening will void your warranty.

Hardware Reset

In the event that your AV400 freezes operation (due to electrostatic
phenomena for example), you can actuate a hardware reset by holding
down on the STOP/ESC button % for 10 seconds. In normal operation,
the STOP/ESC button ¥ will shut down the AV400 after being held down
for 3 seconds.



MUSIC - Playing Music Files

When you click on this icon in the main screen, you will be
sent directly to the Music folder. Use the direction buttons
to highlight one of the factory installed music selections and
then Click on PLAY ©. If you hear nothing at first, make sure
you have adjusted the volume control on the headphone cord. By clicking
on the Music icon in the main menu screen, you will enter into a ‘music
only’ mode. Other playable file types that may be in this folder are only
listed if you enter the folder via the Browser.

S

Music

Current Directory ~ Play Order  Play Mode: One Directory,  Status: Playing ~ Volume (maximum:31)
\ N \ /

' e = Battery level (full)
—J7 IMusic/ D115 E 3:04 Y
Artist* or parent folder ‘\
Album* or current folder\ Wes Burden f; - | Time of Day
Song title or file name ~ T[] Brave New World BT
Mirror

TP I ST File format and rec info
MP3 128 khfs 44.1 kHz

Next track to be played\

H Next track:
Relative location in the tracl\ t‘ Can't Fight This Feeling
N

Song elapsed time | oo opaze  0pams | /
Song time remaining " — — [ R B i~ ]

Song Length @Q\ S}atup IJ; Options l@ Bru\l{se
/ | N\

™ *APIC Album picture

L Volume level meters

7 T N
Go to setup options Show Music Options Browse the hard disk for other tracks

*If the MP3 file contains these ID3 fag data

3.1 Button Control

Increase tIue Volume

Click once: Play the previous song
in the folder or playlist (during first 5 Click once: Play the next song in the
seconds of song) otherwise go to the folder or playlist.
beginning of the song. i B
Hold: Fast forward through the song.

Hold: Fast reverse through the song.

N

© Play/pause/resume song

/]

Stop Song % Decrease the Volume

To lock the AV400 buttons, press and hold the left
function button for three seconds. The Av400 will
display the message “Buttons locked!” on the bottom
of the screen. Press this again for three seconds to
unlock the buttons.

What the Icons indicate

Status Play Order Play Mode
- no icon - See section 17.2
Stopped Play once

' Blinks while playing
a track

UU Pause

@ Recording a track

Z) Repeat playing

Shuffle fran_dom)
track selection

D Playlist

Playing Through your Stereo System

3.2

On your HiFi there are two RCA type connectors that are labeled Aux
in, CD in, or Line-in. Typically they are color coded white and red for
left and right stereo channels respectively. Just
take a stereo mini jack plug to RCA cable (not
included) and connect the mini plug to the
AV400 headphone iack and the other end to the
Aux in, CD --—-.....“..z_*?w,.\__-:
in, or line- .
in of your stereo system. Or better, connect
the Archos TV cradle’s AV Out red and white
connectors directly to your stereo auxiliary
inputs and place AvV400 into the TV Cradle.

On the front of your stereo, select the
corresponding auxiliary input or CD input that you plugged into on the
back of your HiFi system. Press Play and then adjust the Av400 volume
(UP/DOWN buttons) in order to supply your stereo system with a signal
that is neither too weak nor too strong. If the sound is distorted, you will
need to reduce the AV400’s volume. You can turn on and off the built-in
speaker by holding the center function button for three seconds.




Artist, Album, Title ... ID3 Tags

ID3 Tags are information about the recording which found inside of an
MP3 music file. When someone creates an MP3 music file, he or she
has the option of adding information to it. This information can include,
among other things, the name of the artist (Wes Burden), the album
name (Brave New World), the title of the song (Mirror), and a small image
of the album cover (only jpeg images not progressive jpeg). If these data
are present, the AV400 will display them on the screen when it plays the
file. If they are not present, then the Av400 will display in order, the name
of the parent folder, the nhame of the current folder, and then the name
of the file.

As of the writing of this manual, there are two versions of ID3 tags that
are firmly established standards, ID3 version 1 and ID3 version 2. Your
AV400 can read either version of tags, and display the information. If both
sets of tags have information, the data from the ID3 version 2 tag will be
displayed. Other tag information may include year and genre of music.
These other tag data are not displayed by the AV400, but are used to
index your music in the ARCLibrary (see next section).

The ARCLibrary (Browsing by Album, Artist, or Song name)

The ARCLibrary is a system for choosing your music by its characteristics.
It can be turned On or Off in the settings from Setup > Playmode.
As shown in this screen capture, you can select your music by Artist,
Album, Song Title, Genre, or Year. MP3
and WMA music files have internal
data tags to hold information about
the song. For MP3 files, these are
known as ID3 tags. Not all MP3 files
have all this information filled in. If
you purchase a song from a music
download service, the songs will have
this information. If you have an MP3 or
WMA file without this tag information,
then you can add or change it by going
to the properties of the file in Windows® Explorer. Once you re-index into
the ARCLibrary, you will access to this track with the ARCLibrary. Audio
files created with the microphone will be indexed as Artist = ARCHOS
and Album = Audio Recording. The ARCLibrary indexes all the music on

ARCLibraryf N
Werowse harddisk |
Bartist
% album

& Title

yﬁenre

Year
D Playlist

P czesiewel  your AV400's hard drive regardless of

J1 PlayMode which folder you placed it in, by using
IS the ID3 information in each song. When
oe.o you transfer music to your AV400 from
0 Scan your computer, it goes directly to the
Ropeat bsmiffle & nepeat~ @ AV400 hard disk without the ARCLibrary
. . » knowing about the new song. Thus, in
5 — & - 6 order for your new songs to be indexed

SRR into the ARClibrary, you must update
it with the Update button as shown here in the Setup > Playmode
screen. You have the following options to set the ARCLibrary.

Off — From the Music icon, you will just browse music files in the folder Music.

On - You can browse music by its characteristics (ID3 tags) but you will
have to manually update the ARCLibrary each time you add new music
from your computer to your AV400.

Automatic — The ARCLibrary will be set to On and it will automatically
update the library each time it notices that you have disconnected from a
computer. A message screen will appear indicating that it is updating the
ARClLibrary contents.

Setting a Bookmark

'J] fMusic/

D058 3:04 ‘

Wes Burden

Brave New World
|| Mirror s

MP3 128 khis 44.1 KHz w

Hext track: *
Can't Fight This Feeling | .7 "‘.'\ i

0:00:Fit Praylist
S miSet Bookmark |EESESEE———

4] options | T Browse

€. Setup

If you are listening to a song, or perhaps a long recording, and would like
to place a bookmark in it in order to pick up from this point at another
time, you can use the Bookmark function. You simply click on the center
function button labeled Options, then

choose Set Bookmark. This will
ﬁ? set a bookmark in the audio file

at the current position. You can

only set one bookmark per file.
When you look at the file in your browser,
it will have a yellow check mark on its icon —
indicating that this file has a bookmark set
within it. You can have a maximum of 16
files bookmarked. Setting more bookmarks
will then start to erase the oldest bookmarks. The next time you play the
audio file, you will be presented with three options:



Resume: Start playing from the bookmarked position.

Ignore: Keep the bookmark but start playing from the very beginning.
Clear: Clear the bookmark from this file and start playing from the very
beginning.

The Resume Function

icon which is highlighted on the main screen is not the Browser
but rather the Resume icon. This icon is highlighted when the
AV400 can resume the last played audio or video file.

fﬂa When you turn on your AV400 you will sometimes notice that the
4

MUSIC - Playlists

A Playlist is a list of songs that the AV400 will

IF automatically play one after the other. The AV400

(isreemme Can load one playlist at a time into its internal

t".,ad Music memory. You can create new playlists, add or delete

ones songs from a playlist, or Save a playlist as a file (file

type .m3u) to be used another time. There is no

limit to the number of playlists you can save on the

AV400 hard disk. Playlists are indicated by a special list icon (circled icon
to the left).

Playing a Playlist

fHD/Playlistsf I3[~

Kol 1o 0 To play a Playlist, you simply scroll to the
> tparent toer| | IRV Playlist, such as ‘Jazz Music’ shown to the
%f;‘:m’ﬁ. e v left, and click on PLAY ©. The list of songs
will be loaded into the internal memory
of the AV400 and then be displayed in a

separate panel.

pJazzMusic.maquutepad _,_]ELLKJ C“Ck On PLAY o and the SongS WI”
;ﬁm}gévg;ﬁ“ R —| be played in the order shown. To
it cues surden/Through the radn.mps shuffle the music entries in a random

order, you can click on Playlist,
then choose Shuffle. You can open
a Playlist file (Playlistname.m3u) on
your computer with a text editor such
as Notepad, and you will see that it is merely a list of files to be played
along with the hard disk path to find them. If you delete a Playlist from
your AV400, you are only deleting the list and not the music itself.

Example of the contents of the .m3u Playlist file ‘Jazz Music’.



Creating a Playlist

To create a Playlist, press the RIGHT
» button while you are in the Music
browser. A second window will open
on the right side to display the Playlist
contents. You can now start adding
songs to the current Playlist. In the left
- < window, search for the songs you would
@ parent @ A D wnsert like to add to your Playlist. Once the
song is highlighted, click on the Add
function button to add it to the Playlist.
The song will be added to the Playlist and a small mark next to the music
icon will be made to indicate that it is in the Playlist. Continue searching
and adding songs in this manner until you are satisfied. You can also click
the Add or Insert button when highlighting a folder. All the contents of
the folder and its subfolders will be added or inserted into the current
playlist.
You can jump back and forth between the browser and the playlist by
clicking on the LEFT <« and RIGHT » buttons. A Playlist can have a
maximum of 5000 songs. We recommend that you save your Playlists.

4] MP3 416" 128 kbis C@elsHos 36

fMusic/Wes Burdenf J] | Prayistooor~ 7~
.. (parent folder) 4] Brave New Wo

7] Brave New World 4 Mirror

] Mirror

4] Through the rain

Saving a Playlist

It is recommended that each time
you create a Playlist, you save it to a
separate folder called Playlists. These
lists take very little space on your hard
disk and if well named, give you easy
access to your favorite songs. Go to
the Playlist by selecting Music from
the main menu and then click on the
RIGHT P button. You will then see the
list of songs in the current Playlist. Click
the LEFT function button then choose
Save.

ATTENTION: Make sure that your left window is the Playlists folder,
because the open window on the left is the location the AV400 will be
saving your Playlist to.

CI@el158 03:37 (
[HD/Playlists! I |« Playlist0001" 127 |4
[&].. (parent folder| | J] Brave Hew World
IBRoad Music 7 Mirror
[bstones

Close
Rename
Shuffle
Clear B [

@ Playlist | Move IJ] Delete

Save — Saves the current playlist to the folder open in the left window. The
* next to the playlist name indicates that this playlist has not been saved.

Close - Closes the windows and returns to the main menu screen.
Rename — Renames the current playlist.

Shuffle — Randomly shuffles the order of the songs in the current playlist.
Clear — Clears the contents of the current playlist.

Button Move - Allows you to change the place in the list of the
highlighted song. Click on Move and then click on UP or DOWN to move
the song up or down the list. Click OK when finished.

Button Delete — Will delete the highlighted song from the Playlist. It will
not delete the actual song itself from your hard disk, just from the current
Playlist.

Important: Once you save a Playlist it is imporfant that you do nof move or rename the

actual MP3 files as the Playlist searches in the original file location. If you need fo move your
MP3 files to a different folder, you'll have to recreate your Playlist.

Adding songs to a Playlist while listening to Music

This can only be done if you have entered your Music
folder via the Music icon ® and not by the general
browser. To add the song you are listening to or any
other song to the current Playlist, do the following: *

Set Bookmark
£ options

e While playing a song, click on Options and choose
Edit Playlist. A browser window and the Playlist will
open. ‘

e Click on the LEFT <« button to go to the hard disk *
browser window. M Add

¢ Select the song or folder of songs to add, then click
the button Add.

¢ Click ESC % to return to the playing screen.




MUSIC - Recording Music

With the AV400 series, you do not need a computer to create digital
music files. It is capable of recording from the built-in microphone or
an analog line source (ex: HiFi system, Boombox, CD Player, etc) into a
standard Windows® WAV format, either PCM (uncompressed) or ADPCM
(compressed).

Cable Connections for Audio Recording

If you are using the Archos TV cradle, then you will have to plug the
Red and White connectors of the AV IN cables to the output of your Hifi
or other audio device that you are recording from. If you are using the
optional multi-connect adapter and AV cable, you should plug the AV
cable into the AV IN side of the adapter, and then plug the adapter into
the AV400. Now connect the Red and White connectors of the AV cable to
the output of your Hifi or other audio device that you are recording from.

Recording Procedure

Before the actual audio recording begins, there is a pre-recording screen
which will allow you to adjust your recording settings.

0j31M03:36 | IMusict

mejis0oes a1 |

| RECOOO1

WeET [4rsE
— o Microphone, 22 .05 kHz, WAY (P CM)
‘?5" '-"Z-i‘-._ = P
f} g \:L—
FESITE SET

a8 (73 4 L I
ST EEEr Fo T EEEr [ [ i

@ Pocket AV 400 _' Ver. 1.1 EL Setup ]eik Settings [@ Start

1. From the home screen, select Audio-
Corder then click on ENTER/GO ©.

2. In the pre-recording screen, adjust
the recording level* by clicking on the
LEFT and RIGHT buttons. Click on the
right function button to start recording.
Attention, the first time recording you
should adjust your Settings.

20

@503 '

fMusicf

;y AudioCorder

B REC0001

WAV (PCM) [
Microphone D}
22.05 kHz >

Recording Format[4)
Source
Sampling [4)

@503 42 '

RECO0O01
Microphone, 22.05 kHz, WAY (PCM)

03363 KB 0705kbis

I 00:00:21 ]
—_—r = ]

@ . @ . @

Pause

= l-} Next l|:||:|

3. Click on Settings to reveal the re-
cording parameters screen as shown
above. Be sure to set the correct
Source. You will hear silence during
recording and playback if the incorrect

4, Once you have clicked on the Start
button, you can pause the recording by
clicking the same function button (now
labelled Pause), or stop the recording
by clicking on the STOP # button.

source is chosen.

* You should try some test recordings before deciding on which recording level gives the
best sound quality. Don’t be tricked by the volume of the headphones which can be
adjusted independently with the UP and DOWN buttons.

Microphone

The built-in microphone is located on the top of the AV400 unit. Make
sure that you have selected Microphone as the input source in the
pre-recording Settings screen.

Analog Line-In

You can record from any line-level audio source to the AV400. Make
sure that you select the Analog Line-In as the input source in the
pre-recording Setup screen. If you have the TV cradle unit, you can plug
the Red and White connectors of the AV In cables to the output of you
home stereo system or the audio device you are recording from. If you
have the optional multi-connect adapter plug, you can enter a stereo
audio signal into the AV400 directly. Be careful that the source audio
is supplying a line level and not an amplified signal (turning down the
volume on the player will work if you are using the headphone out signal
of your audio device). An amplified signal will make for a terribly distorted
recording. You can also use a high quality pre-amplified microphone, such
as the one Archos sells as an option.



Incremental Recording

While recording, you will notice the center function button
labeled Next. This allows you to create incremental recordings.

That is, the current recording stops and a new recording
instantly begins. The next recording has an additional number appended to
its name. Thus if you create multiple incremental recordings, you might, for
example, have files names of REC0000_01, REC0000_02, etc. This is good
for recording old cassettes and old vinyl records. You can click on the Next
button during the blank space between each song. That way, each song of
the vinyl disk or audio cassette will be one single MP3 file.

Where is the Recording Saved?

The default location for audio recordings is the folder called Music. If you
click on the Music icon in the main menu, you will go to this folder. Notice
that the right function button is labeled Record. Each time you use this
button to record audio instead of the AudioCorder button on the main
menu, you set the recording default location to the current folder. For
example, let's say you have a folder called /Music/Voice/Lectures. If you
go to this folder and then make a recording using the right function button
Record, you will set the default record location to this folder. Now, each
time you use the AudioCorder icon to start a recording, your recording will
be saved in the folder /Music/Voice/Lectures.

Audio Editing

Audio files (microphone recordings / analog recordings / FM Remote
Control (optional)) can be modified by deleting the sections you do not
wish included. If you would like to edit an audio recording, you have the
possibility to “crop out” the exact section of the recording you would like
to save. For example, you have recorded a lecture of 33 minutes and 22
seconds in length. You would like to cut out and save just one particular
important section from 12 minutes and 15 seconds to 21 minutes and 5
seconds. The diagram below illustrates the situation.

Desired audio section
|

¢

00:00 (Omin Osec) 12:15 21:05 33:22

2l
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To keep just this section (cropping it), you will:

locate this file from the Browser mode

Select Edit from the File menu in order to enter the edit mode
In the edit mode, set the cut-IN point (12:15 in our example)
Next, set the cut-OUT point (21:05 in our example)

Save the edit

£ MP3 28" 148 khis VBR 21 @e]z6Blos 39 IJ]IMusicf 2@ Jzag10 50 '
fHD{Voice/Lectures/ 43| i [
[#1.. (parent folder) CUT-IN : &12:15

Jcm || CUT-OUT : —-:--:—-

Jc oz VOICE_D1

$Jc_o3 WAV 1411 Khis 44.1 kHz 16 Bit stereo

¢ 04

Jf1c 05 Hext track:

4] VOICE_02

JIVOICE D3 r

JIVOICE 04 L [ o135 m1gse  mazez |
J]VOICE 05 - —— CEEEEEEEEEEReEE)
[® parent |03 Fie |® Record $ cut-m [ Save |4 Cut-Out

Highlight the file to edit and select Edit
from the file menu. Only files which have
been created with the AV400 recording
function will show Edit in the file menu.
Files created from CDs or downloaded
cannot be edited. Once you enter the
edit mode, the audio file will play in a
continuous loop so that you will be able
to hear how your edit sounds.

Use the fast-reverse and fast-forward
buttons (LEFT/RIGHT buttons) to locate
the points you want the new file to
start and end. These are the cut-IN
and cut-OUT points. Once you have set
these points, you can save the edit. In
this example, a new file VOICE_01_Edit.
mp3 will be made. Your original file is
left untouched. You will notice that your
Cut-IN and Cut-OUT times are marked
just above the file name.



MUSIC - Using Windows™ Media Player 9

' ¥ Media

The AV400 is designed to work seamlessly with
Version 9 of Windows® Media Player (WMP9).
By installing the Archos Service Provider plug-
in, WMP9 will recognize your AV400 as a
connected music device. You can then easily
copy your CD collection to your Av400. WMP9
will encode each song into the WMA format (preferred compressed
format of Windows™) and then store them on your connected Archos
device. This Service Provider plug-in will also allow you to play purchased
music from on-line music services such as Napster.com, MusicNow.com,
BuyMusic.com, and Liquid.com.

6.1

Installing Windows Media Player 9

A Archos Installation Utility

If you do not already have
Windows Media Player version
9 running on your computer,
you can install it from the
Archos Installation  Utility.
Connect your AV400 to your
computer. In Windows Explorer,
open up the hard drive labeled
JUKEBOX. It may be called
JUKEBOX (E:) or with another
letter. Open the folder Data,
then the folder PC Installation,
then double-click on the file Setup.exe. In other words, follow the path
E:\Data\PC Installation\setup.exe. Click on the icon according to your
operating system. Follow the on screen instructions.

6.2

Installing the WMP9 Service Provider Plug-in

You should first make sure you have properly installed Windows Media
Player 9 as explained above. To install the Service Provider Plug-in to
Windows Media player, run the Archos Installation Utility as explained
above, and then chose Archos Media Player Service Provider Plug-in.
Follow the on screen instructions. If you have accidentally deleted it,
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; you can download it from
the Archos website ‘software’
Install Archos WHMOM plugin Category (WWW.arChOS.Com).
With  your AV400 still
connected to your computer,
start Windows Media Player.

Normally, you will connect
m your AV400 to your computer

before you run the WMP9
program. If you connect it after WMP9 has been started, you will have
to click on View > Refresh in order for WMP9 to go check and find the
connected Av400.

6.3

This zoftware iz necesszary to have \Windows Media Flayer
recognize vour 24400 az a compatible device.

Copying Music to your AV400

Run Windows Media Player.

~ *] Mow Playing

Premium
Services

skin
Chooser

2. Choose the AV400 device
then select the folder you
want to copy your songs to.
Now click on Copy.

1. Choose Copy to CD or Device and then check
the songs from your Music Library that you want to
copy to your device.

6.4  Copy Protected Downloads

With music download services such as Napster.com, MusicNow.com,
BuyMusic.com, and Liquid.com, you can purchase music on-line and
then store it on your AV400. These music files are protected with the
Microsoft® copy protection system. When they are downloaded to your
computer then transferred to your Av400, they will play only on your
devices. These files will not play on other people’s computers nor on other
people’s portable music players.


www.archos.com

MUSIC - Using iTunes™ with your AV400
The easiest way to transfer music files between a
— Macintosh® computer and your AV400 is to use the
Macintosh Finder™ to drag and drop the files to and from
U your Macintosh®.

However, for Macintosh® users who do want to use the

AV400 with iTunes®, Archos has developed a special i-
Tunes® plug-in. You will find it in the folder /Data/i-Tunes Plug-in on
the AV400 hard disk or from the Archos website. In this folder you will
find a plug-in for Mac OS 9.x and another folder for Mac OS 10.x. You will
also find a JPEG image illustrating where you need to copy the plug-in to.
Once this is done, iTunes™ will recognize the AV400 as a ‘Device’.
To make your user experience easy as possible, please keep in mind the
following.

1) When you create your Playlists with iTunes® (you can only create Playlists
from songs that have been copied to your AV400), your Macintosh® will
save these Playlists to the root directory of your AvV400. It will not save
them to the AV400 Playlists directory. It would be best to use the AV400
itself to make Playlists (section 4.2) and then save these Playlists in your
Playlists folder.

2) When you drag and drop MP3 files from your iTunes® library to your
AV400, the i-Tunes® program will look at the ID3 tag information (See
section 3.3 of this manual for an explanation of ID3 tags) of the MP3
file, and create a folder on the root of your AV400 using the name of the
Artist as the folder name. Then it will take the Album name ID3 tag, and
create a subfolder with that album as its name. Finally, it will take the MP3
song itself and place it into that album subfolder. Thus, although it is a
clean structure of artists and albums, i-Tunes® does not follow the AV400
convention of placing the music into the Music folder first.
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VIDEO - Playing Video

e
o
e

Video

Like a music file, you simply highlight the video file and
then click on PLAY/GO ©. The thumbnail images on the
right side will show you a frame from the highlighted video
file (center) as well as a frame from the file above and the
file below the highlighted one. By clicking on the Video icon
in the main menu, you will enter into a ‘video only’ mode.
Other playable file types that may be in this folder are only listed if you
enter the folder via the Browser.

To watch your videos on a television,
you must hold down the LCD/TV
button for three second. The AV400
screen will go black and the video
will be sent out to your connected
television. Switch your television to
auxiliary video input (often found just
below channel 1 — sometimes called
L1 or L2). If you don’t see a clear
color image, you may have to set your
AV400 to your local television standard (NTSC or PAL) in the Setup >
Display settings menu.

1B AVI 1h42'38" 21Sep03 155 04:27

4].. (parent folder)
B French Tarte
B Triassic recreational area
i=| The New Salem Cop Beat show
H Crosstone Place
I Hoodlums of Albany

H Leaving with the breeze

ER

E} Parent

e Use the PLAY/GO button to pause/unpause the video.
Long press to switch between built-in video and external
video.

e Use the UP/DOWN buttons to control the volume.

e Hold down the RIGHT/LEFT buttons to fast forward or
fast reverse through the video.

e Click the right function button to Hide/Show the overlaid video time
information.

¢ Click the Options function button to set a bookmark, change the screen
presentation. Press and hold for three seconds to turn the built-in
speaker on and off.



¢ Click on the left function button

to put the video into slow-mo- . ,

tion view. You can cycle through @.?@)
the values Normal, 2, V4 , and kv/
1/8 speed. The sound is muted
when in slow motion. While in
slow mode and paused, you
can step image per image with the LEFT button.

Hide

Setting a Bookmark

If you are watching a video and would like to place a bookmark in it
in order to continue from this point at another time, you can use the
Bookmark function. You simply click on the center function button labeled
Options, then choose Set Bookmark. This will set a bookmark in the video
file at the current position. You can only set one bookmark per file. When
you look at the file in your browser, it will have a yellow check mark on its
icon indicating that this file has a bookmark set within it. You can have a
maximum of 16 files bookmarked. Setting more bookmarks will then start
to erase the oldest bookmarks. The next time you play this video file, you
will be presented with three options:

Resume: Start playing from the bookmarked position.

Ignore: Keep the bookmark but start playing from the very
beginning.

Clear: Clear the bookmark from this file and start playing from the

very beginning.

The Resume Function

When you turn on your AV400 you will sometimes notice that the icon
which is highlighted on the main screen is not the Browser but rather
the Resume icon. This icon is highlighted when the Av400 can resume
the last played audio or video file.
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Display Format Settings

You will notice in the Options button (center function button), that you
have a number of display format options. In certain cases, depending
on how the original video was recorded, you may want to use these
adjustments.

Default mode : Adjusts the video size to best adapt to the LCD screen.

4/3 aspect: Enlarge the image to fill the screen (usually a vertical fill) and
then cut the sides to completely fill a television screen.

16/9 aspect: Send out a TV signal without the black horizontal bars. Will
not be cropped on the LCD.

EM | No Overscan: Picture will not pass into the overscan area. Entire picture
KB | \vill always be seen on all televisions.

Playing Video Files from the Internet

The number of encoding and compression schemes currently used to
create video files is very extensive and seems to change on a weekly
basis. There are so many standards and formats that it is very possible
that the video file you download from the Internet will not play right away
on your device. Due to certain “variations”, even when video files are
formatted in “MPEG4” they may not play right away. The AV400 series
can play video files of type MPEG4 Simple Profile which have an MP3 or
IMA-ADPCM audio sound track. It can play such video files at a maximum
size of 720 by 576 pixels (25 frames/second). The AV400 will not directly
play files of type .mov, .mpg, .mpeg, or .avi files created with codecs
(compression/decompression) other than the XviD and DivX™ MPEG4
codecs. If you have video files of these other types that you would like
to view on your AV400, they will have to be converted first. You will have
to use the software Mp4SP included on the AV400 hard disk to re-encode
them into the proper XviD or DivX™ MPEG4 format with an MP3 or IMA-
ADPCM sound track. See chapter 13 for more details.



VIDEO - Recording MPEGA4 Video Files

‘aﬁ«lﬂﬁﬂ_
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: vID0005

Mantial recording £ Off
- Duration
. Source

0z:00 B
Auto
Auto

RY
1500kh/s
. 32 kHz

- Brightness

Contrast

During Recording

1. Select VideoCorder on the main
menu screen. In the pre-record screen,
you should see movement on the
sound level bar indicating that sound
will be recorded. Adjust the sound level
by clicking the LEFT/RIGHT buttons.
Before starting the recording, you can
adjust the recording parameters via the
middle function button Settings. Click
on Hide Bar to hide the video recording
overlay information.

2. In most situations, the video
recording will work fine without your
having to adjust the settings. However,
by clicking on the middle function
button, you have access to a number
of parameters that you can change
before you start the recording. See the
table below for descriptions. Click any
function button to return to the pre-
record screen.

3. Click on the PLAY/PAUSE © button
to start the recording. While recording,
you will see the length of time of the
recording in the top left of the screen
as well as a red “record” indicator. Click
on the PLAY/PAUSE © button again to
pause the recording. Click on the STOP/
ESC & button to stop the recording.
The AV300 will take a few seconds to
complete the proper saving of the .AVI
video file.
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9.1

Setting the Recording Parameters

VideoCorder

[Rename)

Auto Stop Rec €D On

Duration
Pre-record

Post-record

Source
Format
Reszolution
Bitrate
Sampling

You can set the recording parameters
manually to suit your specific needs.
Click the center Settings button while
in the pre-recording screen.

Wo6:36 |

VIDOD06

B 2:00
B 3 min
Bi1owmn 3
Auto
Auto
TV
1500khis
32 kHz

Rename Allows you to change the filename before the recording begins.

Auto Stop On, Off. If set to On, the AV400 will stop recording after the

Rec duration set in the next line. For example, you want to record
a television show for two hours but do not want to stay around
for the two hours to stop the recording. In the screen above, a
recording that you start manually will last for 2 hours. If set to Off,
the recording will continue until you click on the stop button or
until the entire hard disk fills up.

Duration This is the duration of time your recording will last if Auto Stop
Rec above is set to On.

Pre-record | This is a safety margin added to the beginning of a scheduled

recording which was set via the My Yahoo!® TV scheduler of your
personal calendar. It affects ONLY those recordings. This is just in
case the clocks between your AV400 and the broadcast station are
different or if the broadcast station starts earlier than expected.

Post-record

This is a safety margin added to the end of a scheduled recording
which was set via the My Yahoo!® TV scheduler of your personal
calendar. It affects ONLY those recordings. This is just in case the
clocks between your AV400 and the broadcast station are different
or if the broadcast station runs overtime.

Source Composite, S-Video, Auto. You can choose which video input
you want the AV400 to use. Normally, with a good video signal,
you can set it to Auto, and the AV400 will scan the two inputs to
see which one is receiving video.

Format Auto, 4:3, 5:3, 16:9, 2.35. This is the aspect ratio of the screen

that the AV400 will record. You can set this manually, but in most
cases you can just leave it on Auto.




Resolution TV, LCD. Use this to set the resolution of the recorded image. If you
plan on playing the video most of the time on the built-in screen,
then set it to LCD to record at the screen resolution of 320x240
pixels. Set to TV, it will record at the highest resolution possible.
(Actual resolution depends on 4:3, 5:3, 16:9, or 2.35 recording

format).

Bitrate 500 kb/s, 1000 kb/s, 1500kb/s, 2000 kb/s, 2500kb/s. Use
this to set the encoding quality (similar to the idea of JPEG image
quality settings). The higher the encoding rate, the higher the image

quality but also the more hard drive space is used.

Sampling 32kHz, 48kHz. The sound sampling rate. The higher value gives
a higher quality sound but will take up more space on the hard

drive.

Brightness | Use this to increase or decrease the recorded image brightness

Contrast Use this to increase or decrease the recorded image contrast

Saturation Use this to de-emphasize or saturate the colors in the recorded image

Hue Use this to change the color spectrum in the recorded image

Reset

Change the above settings to the AV400 default settings

Once you have finished changing the parameters, click any function
button to return to the pre-record screen.

Concerning the video standard, the Av400 will automatically recognize if
the incoming video signal is NTSC (American), SECAM, or PAL (European).
There is no need to set anything. You will see the signal type, as well as
the selected aspect ratio on the top left of the pre-record screen.

Click the LEFT/RIGHT buttons to adjust the sound input level. Too far
to the right will often give an overdriven distorted quality. Too far to the
left may make for a very soft sound. Try a few recordings to get a sense
of what is the best sound level. Do not let the headphone volume fool
you. That can be adjusted independently with the UP/DOWN buttons.

If you would like to make a recording in another folder instead of the
default “Video” folder, go to the desired folder via the main Video icon,
then click on the right function button Record.
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Where is the Recording Saved?

The default location for video recordings is the folder called Video. If you click
on the Video icon in the main menu, you will go to this folder. Notice that
the right function button is labeled Record. Each time you use this button to
record video instead of the VideoCorder button on the main menu, you set
the recording default location to the current folder. For example, you have a
folder called /Video/Television/Documentaries. If you go to this folder and
then make a recording using the right function button Record, you will set the
default record location to this folder. Now, each time you use the VideoCorder
icon to start a recording, your recording will be saved in the folder /Video/
Television/Documentaries.

Copy Protection

The AV400 video recording system is designed to respect the copyright
protection system. If the source of your video is copy protected, the AV400
will record in protected mode. You will see a “P” icon on the recording screen
(not playback) indicating that the file will be a protected file. Protected files
can only be played back on the AV400 that created it. The file will not play
on a computer. Further, the playback of protected files will be limited to the
built-in LCD screen and not to an external television.

Manually Setting the Scheduler

If you would like to make a video recording for a future date or time, you
can use the scheduler. You can find it by going to VideoCorder and then
clicking on the right function button Scheduler. You can program up to
twenty different recordings up to one month in advance. Once you program
your dates and times of recording, press the left function button SAVE. You
can now put your AV400 into standby mode by pressing on the red Standby/
Off button on your Archos remote control. Once the scheduler is set, you
will see an icon on the top Videocorder status bar indicating that it is set to
make a timed recording.



» Click on the right function button Scheduler.

 Set each line to the desired date and time (and channel if you are using
the InfraRed emitter to control your VCR, cable box, or satellite receiver).
Click on the center function button Title to set the file name of the
scheduled recording. Click on Save.

« The scheduler icon & indicates that a scheduled recording is set. You can
set the Av400 to Standby.

Biaas | [os 53 |

Date Start End Channel Date Start End Channel

== Current 0616 11:00p 02:00a - - - Current

06/16/2004 - 11:00p
06/17 09:00p 10:00p - -

== Current = Current

06/17/2004 - 09:00p
| 06120 05:00p 06:30p - -
Senate Coverage Bill H4123

== Current = Current

== Current = =f= = === Current

Clear Save Title Clear

Empty Scheduler, ready to be
programmed. Once a valid record

Scheduler after having been set. The
"--- Current” means that the AV400

time is entered, and the Enter button
pressed, the empty box will get a green
checkmark.

Notes about setting the Scheduler.

e The scheduler

will record the current video signal (no
channel changing). This is for people
who do not use the stick-on Infrared
Emitter system.

automatically reorganizes the recording events
chronologically.

In order for a scheduled recording to start, you must leave the AV400
in the main menu screen or set it to standby mode (press Standby/On
button on remote control). That is, if you are listening to music, watching
a video, or looking at photos on your AV400, it will not interrupt you in
order to go make the scheduled recording.

If you have connected and will be using the IR Emitter system (see the TV
Cradle manual as well as section 11 below) with a video cassette recorder
(VCR) please note that in order for the IR Emitter to properly control the

VCR:
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1. Your VCR should not be left in sleep mode.

2. Some VCRs will shut off automatically after a few minutes when left
on. See your VCR user manual for instructions on how to force it to
stay on continuously.

When the user interface is in English, the Date format is set to Month/
Day.

If the end time is earlier than the start time, then it is assumed that
you start recording on the start date, and the recording ends on the
following day at the end time. For example, the first scheduled item in
the screen above will start recording on the 16th day of June, and end
on the 17th at 2am.

Once a scheduled recording has been made, or the date of a recording
has been passed, without the recording having been made (the Archos
unit was not in the TV Cradle or not in Standby mode), the schedule
entry will be erased from the scheduler.

Long recording times (2 hours and more) can create files that are
greater than 2GB each. The AV400 will create multiple files in order to
make long recordings. Thus a long scheduled recording may produce
video files called VID0000, VID0001, and VID0O002. This is only in the
case of recordings that are over 2GB in size. This 2GB file size constraint
is due to the Windows™ FAT32 AVI file type specification.

When you set the scheduler, the AV400 will create a text file its System
folder called DVRTimer.txt. You should not erase this file.



Automated Yahoo!® TV Recording Scheduler

For those who have a My Yahoo!® account and use the calendar feature,
the AV400 can read the TV programs scheduled into your personal
calendar and thus make scheduled recordings this way. You can sign up
for an account and learn how to use the My Yahoo!® TV and calendar
functions at the Yahoo!® Website (www.yahoo.com).

You must do the following:

(o) O, BN

1. Connect your AvV400 to your computer.
2.

Go to your personal Yahoo!® calendar which has your TV programs
scheduled.

. Choose the Week view — starting with the current day as the

beginning of the week.

. Click on Printable View to show a cleaner printable version.
. From your browser menu click on File > Save As... to save the file.
. Do not change the File Name, but do change the Save as Type to

Web page, html only. Now save the file to the folder System on
your AV400.

Once you disconnect the Av400 from your computer, the AV400 will
automatically update its scheduler with the newly saved TV programs
from your My Yahoo!® Calendar. If the AV400 encounters a television
station name that it does not know the channel number for (was
never set), it will indicate so, and direct you to go to the scheduler to
manually assign a channel to the station name.

Notes:

If the TV programs from your personal calendar do not seem to be
correctly copied to the AV400 scheduler, go to the Archos web site to
make sure that have the very latest version of the Av400 firmware.
Update your firmware (Operating System) as explained in the chapter
“Updating the AV400 firmware”.

If you change your Yahoo!® personal calendar by deleting some TV
programs and adding new ones, only the new programs will be added
to the AV400 scheduler when you save the html file to the AvV400. If
you want to delete scheduled items, you must do this in the AV400
scheduler itself.

Missed recordings (because you did not have the AV400 in the TV
Cradle connected to your Television at the record time) will be deleted
from the scheduler.
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If a personal calendar recording event does not find the station name
in your list of channels, it will put the event into the scheduler and
mark it with a ?, indicating that you must assign a channel number to
the name. Move the cursor to the line containing the ?, and click on
the center function button “Set Channel”. You can now scroll through
the channel numbers and assign a number to the station name for
that event. You only have to do this once.


www.yahoo.com

VIDEO - Setting the Infrared Emitter Code

This is a one time step to set your AV400 to send the correct infrared codes
to your video cassette recorder, cable box, or satellite receiver in order that
the AvV400, via its TV cradle, can turn on and off your video device and also
change its channels. If you do not plan on making scheduled recordings,
then you do not need to install the IR emitter or set the infrared emitter
code.

Before beginning this procedure of setting the emitter code, your Av400
must be connected in the TV Cradle, the IR emitter cable plugged in and
securely stuck in place on your tuner’s (VCR, cable box, satellite receiver)
infrared receiver window. See the TV Cradle instructions for the exact
placement of the emitter.

Part 1: Choose your Device, Brand and Model

On the main screen, go to Setup then click on TV Control.

A = (t:"&-\_\ Tune IR Emitter
:,f. 1) /'. ! (R

A

e e TV source 1 Cable Box »
Sound PlayMode Clock B p P 5
k) “'3-\; e
i N A 1 Tune IR Emitter
2 3 ol
Display Power System

TV channels

(R
TV control

1. Select the type of device that you have stuck your IR Emitter to. You
have the choice of either a VCR (video cassette recorder), Cable
Box, or Satellite Receiver.

2. Select the brand of your device.

Click on Tune IR Emitter button.

4. The TV channels button allows you to give names to each channel.
For example, if channel 6 is CNN then you can name it in this screen.
You can fill these in by hand. Or, if you use the My Yahoo!® personal

w
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calendar to set your recording scheduler, any unknown station name
will be indicated in the scheduler with a ?. You then have the
possibility to assign a channel number to the station name by clicking
on the center function button Set Channel. This avoids having to fill in
all the station names and channel numbers by hand.

Part 2: Testing the Emitter codes

. Tune channel select: These four _ wzsGio:ss
parameters usually do not need to be ‘& —
set. Keep the default values to start with. ol ore :
See the table below for an explanation of e EeA ore :
each. E::z device code fl:r Panasogiﬁ;a .

Test: ON/OFF

. Tune device code (one code Lest el oect

available): Some manufacturers use @ - @ . |®

only one set of codes for all of their

products. Their codes do not change from one model to another or from
one year to another. In this case, there will only be one single code. You
can now test the channel select.

. Tune device code (multiple codes available): Some makers of

video equipment don’t use the same set of control codes for all of
their products. They have various code sets for various models and
various years. You will have to try each of the codes to find out which
code works with your device. In the example screen, you see the
code C109. If this code does not work when doing the Test: channel
select, advance it to the next code and then test to see if that next
code works.

. Test channel select: When you press the Test channel select button

(Highlight test channel select and press ENTER © button —on Av400),
the Av400 will send a signal through the cradle to the Infrared Emitter
stuck to your device and changes the channel. If the Number of digits
parameter is set to three, it will try to select channel 123. If that
parameter is set to 2 or 1, it will send the code for channel 12 and
channel 1 respectively.

. Test ON/OFF: When you click on the Test On/Off button, the AV400

will send a signal to the TV Cradle, which will then send a signal out to
the Infrared Emitter stuck to your device and turn your device on and



off. Click this test button again and your device should change from on
to off or off to on. If pressing this button does not turn on and off your
device, try the next code for your device (step 3 above). If none of the
codes work, check that the infrared emitter is directly over the infrared

VIDEO - editing Video Files

sensor on your tuner device.

Note: In some rare cases the ON/OFF functionality may not work.

Parameter Description

39

40

Video files recorded by the AV400 can be modified by deleting the sections
you do not wish included. The editing you can do is either cropping or cutting
of particular segments of the video file. You will mark a segment of your
video file, and then you will tell the AV400 to CROP it out (delete everything
except the marked segment) or to CUT it out (delete the marked segment
from the video file). These operations can be done multiple times on the

Key: -/-- Set this to On if normally, you have to press this same same video file. Once finished, you will have the option to save the edit
key on your device’s remote control in order to select a marks with the video or to write a new video file. If you save your file with
channel. edit marks, you can always go back and change your edits at another time.

Number of digits | Set the number of digits that your device can recognize The actual video information is not deleted. On the other hand, you can write
for a channel. Example: Set to 3 if you need to choose a a new file which will only include the video parts that you specified in the edit
channel greater than channel 99. session. This file will be smaller but you can never un-edit it.

Key: Enter Set this to On if normally, you have to press the Enter
key on your device's remote control after you enter the
channel number. Example: If you normally press 1, 3, Beginning of recording Music Video section to keep
Enter for channel 13, then you would need to set this (a) (b)
parameter to On. ‘ | ‘

Key Delay Change the delay between the emission of each digit of a
channel. You may need to adjust this if the AV400 seems Example 1: You have recorded a music video program and would like to
t‘; Seng 0n|Y| hg'f thel d'%s, 0‘; ?hChznni', CI” mors d'?'ti keep one single music presentation. The rest of the television recording
ol a channel. txampie: Jus € Key aelay ana retes .
channel select if it sends channel 1 instead of 12 or sends you_do_not care to ke_ep. In this case, you would set a Start mark (a) at the
112 instead of 12. beginning of the desired segment, and an End mark (b) at the end of the

desired segment. You would then choose CROP which would then delete
everything except the designated section.

to delete

(@ |
.

to delete

|to) (@) [ o)

Example 2: You have recorded a television program but would like to remove
certain sections before the program started, parts during the program, and
the program afterwards because you had recorded a little extra. In this case,
you would make a Start mark (a) at time 00:00 and then forward to the end
of what you want to delete and make your End mark (b), and choose CUT.
This part of the video recording will now be cut out. Fast-forward to the



center of the recording and make a Start Mark (c) where the section that
you want to suppress begins, and make an End mark (d) when it finishes.
Again, choose the CUT option and this section will be cut out. Do the same

for the final section that you want to cut out.

IMPORTANT NOTE: When you pause at a given point to make a Start or End
Mark, the actual point of the cut will be the nearest I-Frame. I-Frames are special
frames in the video file which come about every one to four seconds. The editor
can cut ONLY at an I-Frame. It is thus recommended that when you pause at the
point you want to make your Start or End mark, that you click the LEFT button
once (will jump to the previous I-frame) and then click the RIGHT button (shows
the next I-frame) so that you can see your choice of I-Frames to cut at. Go to
the I-Frame you desire and then set your Mark. Trying to set a mark between
I-Frames is ineffective since the AV400 will just choose the closest I-Frame.

11/426[|o1 56

f;.

aisat'night television

il Sat night television 11/426[=/01:58

= aﬂw‘\ 2

il Sat night television{edity* 11/426[=]02 02

éﬁd i R

1. Play the file and pause
at the spot you want to
make your Start mark.
Click the RIGHT button
once, then LEFT once,
and choose the I-frame
you want for the mark.
Click on the Edit function
button and select Start
Mark.

2. Let the video play.
Now click on Pause at
the location you want
to mark the end of your
segment. Choose your
I-frame and then select
End Mark from the
Edit menu. You can now
click on the Edit button
again and choose to Cut
or Crop the specified
segment (blue portion in
the time line.)

3. Continue to mark
other segments that you
would like to delete and
use the edit Cut function.
Once satisfied with your
edits, you can Save Edit
which keeps the edit
points and allows you to
re-edit another time, or
you can Write to new
File which will create a
new edited file named
(old-name_Edit0000).

4]
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VIDEO - Creating MPEGA4 video files with
your computer

How to create an MPEG-4 video file

Please understand that video re-encoding is not always a simple one button
process. Video segments that come from your digital camcorder or which
are freely available on the Internet are encoded in many different ways. If
not already in the proper MPEG4 Simple Profile format, transforming these
videos into this format readable by the AV400 requires use of the below
mentioned software tools. This is due to the relatively new nature of the
ISO (International Standards Organization) MPEG4 video format. Unlike its
predecessors MPEG1 and MPEG2, there are a number of levels in this format
and thus not all MPEG4 video files will work on all MPEG4 players, and older
MPEG1 and MPEG?2 files must be re-encoded into this format. Although you
may have a bit of a learning curve in the initial re-encoding of video files,
once you have the process down, it is just a matter of letting your PC or Mac
go to work and create video files for playing on your AV400.

PC Tools

The AV400 is delivered with two Windows® based programs that allow you
to create MPEG4 Simple Profile .AVI video files. They are the MP4 Translator
and Virtual Dub™. The MP4 Translator will call the Virtual Dub program
and give it the correct parameters to encode your video from its original
format, .avi or .mpg (mpeg 1), and then encode it into a DivX™ based
MPEG4 .AVI file. The file will be scaled in order to be played back properly.
Only MP4 files encoded with DivX™ or XviD can be played on the Av400. If
the DivX™ codec is not on the included CD-ROM, please visit the website of
DivXNetworks, Inc (www.divx.com) to download this codec. This is a free
codec. This will allow your PC to create DivX™ type videos which play on
your AV400. You will also need an MP3 audio codec (available freely on the
Internet) in order to create the proper sound track for the movie.

Macintosh Users

Until recently, the Macintosh user community did not have any tools to create
DivX™ simple profile MPEG4 video files. There are now tools available for
purchase at the DivX™Networks web site which will allow you to create DivX™
simple profile files with your Macintosh that are playable on the AvV400.



Installing the PC Software

If your video file is not an MPEG4 Simple Profile .avi file of the proper size,
you will need to re-encode it using the following utilities. For the AV400,
you will need to create an AVI file that is MPEG4 Simple Profile with a
resolution up to 720 x 576 (depending on frame rate) and a sound track
that is stereo MP3 or WAV. In actuality, in all cases, a resolution beyond
640x480 does not add any advantage.

Run the program SETUP.EXE (the Archos Installation Utility) found on the
AV400 hard drive in /Data/PC Installation. Please install the programs
in the following order.

DivX™ Codec

This software will install the DivX™ Compression/Decompression onto
your PC. You should shut off any anti-virus programs when installing this
or other codec software. This is not a program that is run by itself. Rather,
it installs background software which allows your computer to do high
quality video compression. This is the MPEG4 compressed video type that
the AV400 knows how to play. You can find this codec software, as well
as an application that allows you to play DivX™ videos on your PC, at the
website www.divx.com. The standard version is one best suited for your
Av400.

Virtual Dub™

A utility for transcoding one video file into another. This is a general
purpose transfer and cleanup utility which has many options allowing for
even the most difficult video translations. When you install it with the
Archos Installation Utility, it will automatically unzip. It will prompt you
to save it to C:\Program Files\VirtualDub. You should use this default
directory location. Otherwise you will have to instruct the Mpeg4 translator
program where to find it.

MPEG4 Translator

This program, developed by Archos, is a “Front-end” for the Virtual Dub
program. It has a simple interface which you use and it then tells Virtual
Dub how to process the video file. It sets all the parameters for Virtual Dub
specifically to create a video file in the right size and format to be read by
the AV400. When you run it for the first time, the MPEG4 Translator will
need to locate the Virtual Dub program. If you did not install Virtual Dub
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in the default location, you will have to show the program where Virtual
Dub is.

MP3 Sound Codec

If MP4SP detects a suitable MP3 codec on your PC, it will use it, and your
video file sound track will be MP3. Otherwise, it will use the standard IMA
ADPCM codec. There are MP3 encoders (usually packaged together as
an encoder and decoder) available on the Web for you to download. If
you choose to use the LAME codec, make sure that you have a version
built with the ACM front-end. You can find other MP3 codecs on the web
by using the search terms ACM, MP3 and CODEC in your favorite web
search engine. Once this MP3 codec is installed into your system, Mpeg4
Translator will be able to create final video files with MP3 sound, even if
the source video file does not have an MP3 sound track.

If you are unsure what codecs (audio and/or video) have been installed
on your computer, you can see the list by going to the following location.
For Windows XP, click on Start > Settings > Control Panel > Sounds
and Audio Devices Properties >
Hardware > choose Audio Codecs, then
click on Properties. You will find a list here
of all the audio codecs that are installed
on your computer. Decoding of MPEG 2
video files is currently not supported by
MPG4 Translator. These are usually .mpg
or .mpeg format files, not the required AVI
file. There are other tools found on the
Internet (FlaskMPEG, Rippack, etc.) that
may be downloaded in order to help you
with these file types. A good starting place
is the website www.digital-digest.com.

Using MPEG4 Translator

To the left you see the image of the main MPEG4 Translator program. When
you first run the program, if the DivX™ codec has not been installed yet,
you will be notified. You should download the codec and install it on your
computer. If the Virtual dub program has not been installed, you will also be


www.divx.com
www.digital-digest.com

notified, and you should install it (either with the Archos Installation Utility
or the Virtual Dub website). If you have placed the Virtual Dub program in a
folder other than the default, it will ask you to locate the file.

Select Source & Destination Files

E9 MPG4 Translator v3.0.6 © Archos
Help

This program conwerts AV files of various formals into
V) suitable for the Archos Jukebox Mulimedia

24 hour:

el Gt s (e Click here to select the source video file,
ource
S BT Click here to enter the destination MPEG file:

standard MPEG4 Simple Profile

S File.

In the example above, a source file 24
hours of Lemans.avi has been selected
as the source video. You can see on
the bottom of the window its original
characteristics (width 720, height 576,

Destination File.

00 avi
Change Settings Click here to change the MPEG4 encoder settings.

Taiget
|Pocket Video Riecarder Av400 ~|

frame rate 30). Next, you must then
tell the program where to place (Set
Destination file) the newly recoded
version of the file (don't worry, it will
not erase the original). You should
give it a new descriptive name, such
as shown above Lemans_AV400.avi.
Make sure you add the .avi extension.

v & 40D

Start Click here ta start the hianslation into a Simple-Profile
MPEGA.AY].

‘width Height fps
Source Picture Size 720 576 23976
Destination Picture Size 20 128 23976

Dl Click here to Exit

Change Settings

- Next, you can change the
Variable bitrate mode : [JHAEE = e Bitrats kbips ”

Oktpe mm/hu,’% parameters (Change Settings) of
Encoding bitrate: —JI 800 kbps!

the DivX™ encoder to adjust the

level of quality of the final image.
Like MP3 music, the higher the bit rate setting is made, the higher the
quality of the music, or video in this case, that you will get. However, this
will also take up more space on your hard disk. A setting of 900 kbps will
give you a nice looking image for viewing on a television. For near DVD
quality, you can set it up to 1200 kbps.

Target & Priority

You should select the target as AV400. You will see a Priority box appear.
This control is to allow you to select which feature of the video to be
guarded. If for example you are re-encoding a video file that is 800x600
in resolution and 30 frames
per second, this is beyond the
maximum resolution that the
AV400 can play. Thus, the MPG4
Translator program will have to

Target
Archos Video 44400 j

Priority
TV

G e
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decrease the resolution. Choosing LCD optimizes the final video format
for viewing on the built in LCD screen. Choosing the TV option will
optimize the movie to keep the highest possible frame rate. You can see
what the size and frame rate will be by looking at the Video Image Size:
Destination parameters. When choosing TV, it is understood that the
output will be optimized for a television, and not the built-in screen.

Start

Click on Start and the program will call Virtual Dub to start processing the
video. Depending on the power and speed of your computer, this could
take real time (@ 60 minute long video re-encoded in about 60 minutes)
or much longer. As shown to the left, you will see the progress as it
processes the video file. If the Start button is grayed out, it would be for
one of two reasons. 1) The source file is not a true AVI file. Even if the
file name ends with .avi, the internal file data
determines if it is truly an AVI file. 2) The
Virtual Dub program was not located when
Mpeg4 Translator was started up. Close the
program, restart it, and make sure you locate
the Virtual Dub program.

VirtualDub Status - [24 hours o... Eﬂi‘@

Main I\f’\den ] Perf ]Lng I

Curent viden frame: 3483107538
Current audio sample: 0/0
Yideo data: 18.1MB [128KB/5)
Audio data; 0 bytes
Projected file size: BE0.26MB
Video rendering rate; 439 fps
Time elapsed. 1:14
Total time: (estimated]): 3813

Progress: 1

Processing thread priority: | Mormal o

[ Show input video
[ Show output video




PHOTO - Viewing Photos

@: The AV400 series support the viewing of JPEG (.jpg) and
bnote BItMap (.bmp) image formats. Progressive JPEG images are

not supported. The AV400 will resize the image to fit on the

built-in screen or on a television screen if you choose the

television output. The yellow bar above the list of files indicates that
you are in the ‘Photo Only’ mode, meaning that only files of type JPEG
or BMP will be visible in the directory. The three images on the right are
thumbnail sized pictures of the
highlighted file (center) and
the picture just before and just

1155 04:27 |

. JPG 16001200 03FebhD4

fPhotof
(#.. (parent folder)

EDIMG_0424 after the highlighted file.
e If you are viewing photos on a
me 0427 television, it is recommended
::3;333 thatyou settheImage Display
CIIMG_0430 setting to Progressive to
GElIMG_0431 . .

BIMG_0432 eliminate any possible screen
e e flicker. You will find this in the

[#] Parent I File I@

menu Setup > Display.

14.1 Viewing Photos

When you click Enter © on a highlighted image file, the AV400 will display
the image in the carrousel, either alone, within a group of 4 images, or
within a group of 9 images. A red rectangle will surround the selected
photo. Click on Enter @ again to display the image in full screen. Once it
is displayed as a full screen image, you can rotate it, magnify it, or set it
as the AV400 screen background (Wallpaper).

IMG0007

1 x 1 image 2 x 2 images

3 x 3 images

a7
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IMGO007

Rotate picture 90° left View next photo

/(t\\
A = V4
G ican)

/I
/

Rotate picture 90° right

¢ Click the left function button #-Pic to change the number of photos in
the carrousel view.

¢ Click the center function button Picture to display the picture options.

e Click on the right function button Hide to hide the picture name and
function buttons.

View previous photo

Magnifying Photos

Once the picture is displayed in full screen, clicking the PLAY/GO button © will
magnify the image up to three levels. Each successive click of the PLAY/GO
button will magnify the picture one more level. You can use your direction
buttons to move the picture around in order to see the desired magnified
area. The small + signs on the bottom left of the screen indicate the level of
magnification, either +, ++, or +++. Click on STOP/ESC % to go back to an
unmagnified view.

14.2 Viewing a slideshow

'8 JPG 1600x1200 D3Feh0a

fPhotof
@.. (parent folder)
CIIMG_0424

_unsgusze, By clicking on Slideshow, the Av400 will present
each picture in the current folder for a set amount
== of time and then go on to the next picture. You
——— [V { Iy can set the amount of time that each picture
. = stays on the screen under Setup > PlayMode
Revame "¢ > Picture Pause. This parameter is the number
' of seconds each picture displays on the screen.

BIMG_0428
CElIMG_0429
BIMG_0430
EHiMG_ 0431
CEIMG_0432
HiMG_ 0433

[ Parent

Create Folder
File

14.3 Transferring photos to your AV400

To transfer pictures from your digital camera directly into the Av400, you
will insert your digital camera’s Compact Flash™ card* into the slot on
the left side of the AV400. Insert the card when the main menu screen
is displayed.



When you insert the card, the AV400 will
| recognize it and open up two browser windows.
j \./\f,!‘ The left window will show the contents of your

- CompactFlash™ (CF) card* and the right window
will show the contents of your AV400’s hard drive.
Navigate to the folder on your CF card which
contains your photos (in this example /DCIM/
113CANON). Move to the right window (click right
button) and navigate to the folder you would like
to save your photos to (you can create a new folder if you need to by
clicking on the center file button).

JPG 6402480 20Apro4

IDCIMIM13CAMONS
[3.. {parent folder)
EEIMG_1310
& IMG_131
IMG_1312
2 IMG_1313
& IMG_1314

p]2s[]19:44
«|fPhoto/Campingf |~
.. {parent folde

JPG 6402480 20Apro4

IDCIMAT3CAMONS
[1.. {parent folder)
BEIMG_1310
EIMG_131
EIMG_1312
EIMG_1313
EIMG_1314

p]25g]19:44

a|fPhotof Camping! ||

.. (parent folde [l
& 1MG_1310
€ IMG_1311
™= IMG_1312
& 1MG_1313
& IMG_1314
€ IMG_1315
€2 IMG_1316
& I1MG_1317
= IMG_1318
hd 5 IMG_1319

BEIMG_1315 B IMG_1315
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Photos from CompactFlash™ on the
left, and your AV400 hard disk on the
right. Choose destination folder then
choose File > Copy All.

Your files will be copied to the folder
on the right side of the screen. You
can now pull out the CF card from the
AV400.

If your image files are not seen in the left screen, you may have to go the Setup
> System > Show all files parameter and set it to On. Once set to on, all file
types, regardless of their extention (.txt, .raw, .pdf, etc.) which are on your CF
card will be visible in the left browser screen. You cannot copy files to your CF
cards from your AV400.

*If your camera uses SmartMedia™, Memory Stick® (MS), MultiMedia Card (MMC),
or Secure Digital™ (SD) memory cards, you can purchase the optional Archos 4-1
CompactFlash™ adapter which will allow these card types to be read by the AV400.
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BROWSER - Using the Browser

The browser is used to navigate the file system on the
AV400. The file system is FAT32, the same type of file system
that is found on Windows® based computers. That is, it is a
hierarchical system which includes folders and subfolders.
Because you will be putting hundreds of files on your AV400,
it is STRONGLY ADVISED that keep a neat and orderly file structure.
Otherwise, you will be spending time searching for files and not listening
or watching them. We suggest that on the first level of your file structure,
you include the folders: Data, Music, Playlists, Photo, Video, and Voice.

Video

Browser

%:)

Music

Photo

The folders Music, Photo and Video are special folders in that the icons
on the main screen lead to these folders and then places you directly in
that folder. If these folders are deleted, you will be placed at the root level
(highest level) of the directory hierarchy.

Navigating the Directory Structure

Just below the top status bar, you
can see the path to the directory
you are currently viewing.

To naV|gate the directory structure you will use:

ENTER © Open the highlighted folder (directory) or Play the
highlighted file.

Husic ves Burd -I

-‘narent foldo:

ESC/STOP % Go back to the main menu.

(& Parent ] Go to the parent directory (go back up one level).

‘ Example: Go from folder /Music/Wes Burden/ to /Music.




Move the cursor up and down to the previous or next file or
folder.

Navigating the Directory Structure

Depending on where you are in the directory system, you will have the
option to manipulate files and folders. From the main menu, click on
Browser. Attention, there is a setting in the Setup > System menu called
Show all files. If this is set to Off, the AV400 will only display file types
.mp3, .jpg, .avi, etc. That is, it displays only the file types that it knows
how to play. To see all your files, including ones it cannot play, change
the Show all files system setting to On. Files that it cannot play will be
preceded by the unknown file type icon @

File Operations Folder Operations

J'J MP3 7'34" 128 kbfs

IHD/MusiciWes Burden/
[#].. (parent folder)

gJ31[17 10

THDfMusic! o
[ 1The Beach Boys

gj31f17:09

—

4] Brave New World [ Ime Beatles

4] Mirror [ 1Te Byrds
EIThe Doors
[C1me Eagles
[CJThe Kinks

DThe Moody Blues

[_IThe Folice B
EIThe Rolling Stones Create

Delete CIThe Who Delete

Rename - EI Yes Burden Rename

@ Parent | Fie |01 Folder @ Parent |® C1  Folder

Info: Show file information such as song length, video length, photo
size, number of kilobytes used of hard disk space, date file was
made, etc.

Delete: Delete the file permanently from the AV400. (Before it is

deleted, the AV400 will ask “Delete file: xxoxx ?”. Use
the function keys to reply Yes or No. For folder, it will delete
the entire contents of the folder. It will ask “Delete folder:
xxxxx and all files therein?” Use the function keys to reply
Yes or No.
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Rename: Change the name of the file or folder to something new. You
will be sent to the virtual keyboard (see section 15.3) to enter
the new file or folder name.

Create a new folder in the current level of the directory. You
will be sent to the virtual keyboard (see section 15.3) to enter
the new folder name.

Create:

Copying and Moving Files and Folders

By using the unique Archos double browser system, you can copy or move
files from one location in the file structure to another (1000 files per folder
maximum). You simply click on the RIGHT button, and a second browser
window will open. The double browser can be used in:

Photo View: Left browser is an inserted memory card and right
browser the AV400 hard disk.
Music View: Left browser is the AV400 hard disk and right browser

the music Playlist.
Browser View: Two browser windows to browse two different parts of
the AvV400 hard disk.

In the Browser mode, you can jump between the two windows using the
LEFT and RIGHT buttons. Where the cursor is highlighting a file or folder,
that window is the source for the copy. The destination folder will be the
other window. For example, we want to copy the file Project X.doc from
the HD/Data/Files from Work folder to the HD/Data/Backed up

rrrrrr

haf10:45 aJ18 @ 10:45

fHD/Data/Fles from Works
.. (parent folder’
9Project X.doc

IHD/DatafFiles from Work/! - |fHD!
.. (parent folder’ =__|Dau1
HProject X.doc

[Paylists
[video
[voice

@ Prem @ [0 Foiver [@ parent  [@ [0 Foler

1) Locate the file to copy. 2) Click the RIGHT button to open a

new browser window.



rhefl10:24
/HD/Data/Backed ||
(.. (parent. folder

L

File |C1Fotder

ghaf1 08
...Files from Work/| ~ [fHD/DataiBacked up files! fHD/DataFiles from Work/
(&.. (parent folder [E3.. (parent folder p
FlProject X.doc []Coleman Files
[ Ipurand Project

@ Parent @ [T Foler r@ Parent

3) Click the RIGHT button again to
move the cursor to the right browser
and find the desired destination folder.

4) Move back to the left browser (LEFT
button), highlight the file to copy, and
select copy from the file menu. The
file will be copied to the folder in the
right browser. Entire folders can also be
copied or moved in this same manner.

Using the Virtual Keyboard

It is recommended that you create folders and rename files or folders
from your computer when it is connected to the Av400. The computer
keyboard is much easier. Often times, however, you are not near your
computer and you must enter the text directly with the AV400. For this,
the virtual keyboard screen will appear.

The new text that you are typing in Cursor
_‘ / 1]i5[03 39 Each key has an upper case and lower case
[— character (lower case mode shown here).
B ) e ) ) 4 h| i
Press ENTER o to enter thehighlighted key.
il "k 1] .~ m} ~'n] o] p A r] s
A 5 7 B 7 I 1A A Hold down on the LEFT or RIGHT buttons to
—— move the cursor within the line.
+ 4 £ o & 4 H [
@ < =
—(u ]‘: .l {QA . Change keyboard between upper case and
Save Delete Shift
/ ~ lower case
Confirmation to use the entered text Backspace button
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Connecting/Disconnecting the AV400 to/from
your PC

Note that when the AV400 is connected to a computer, it will use more
energy than usual. Your battery power will be consumed at a higher
rate than normal. If the AV400 looses power while connected to your
computer you could damage your directory structure and/or loose data.
Thus, you should always use the AC adapter when connected to your
computer. Be careful to understand the disconnection procedure also
since disconnecting incorrectly can lead to data loss or computer/Av400
freeze up. The AV400 is not compatible with Windows® NT, Windows® 95,
or Windows® 98 (first edition). Windows 98SE® (second edition) users
must download the USB driver from the Archos web site. While connected
as a hard disk to your computer, the AV400 buttons are blocked and are
no longer functional.

Connecting the AV400

1) Use the power adapter to prevent the AV400 from shutting off due to
low power. (This could cause damage to the contents of the hard disk
if not done.)

2) Plug the USB cable into your running computer.

3) Turn on the AV400 — wait until it completely boots up.

4) Plug the other end of cable into your now running Av400.

Windows™ ME, 2000, XP (Home/professional)

When connected, the AV400 will be
Q- (0 T sewn | rotes | [T recognized as a Mass Storage Device and
e e 10 display automatically within a few seconds
B Foenironitn “9‘ of being connected. You will see a new
B Chonge  seting S Lol ) drive letter, such as E: in My Computer
Ot Places. B D oveos called JUKEBOX. You can now use the
bR \@ hard disk called JUKEBOX like any other
E“i. e external hard disk. Simply access it using
L) s Windows™ Explorer to drag and drop files

Details =

to and from the AV400's hard disk. If it is
not automatically recognized, please refer
to the troubleshooting section at the back of this manual.



Macintosh™ OS 9.X

EERESL SR, - You must update your operating system to a minimum

' of version 9.2. Once done, you will not need any special
drivers or extensions. You simply plug the AV400 into
your Macintosh as enumerated above, and within a
few seconds, the AV400 will be recognized as a mass
storage device (Hard Disk) and mount on the desktop.
You can now use the Hard disk called JUKEBOX like any
other external hard disk.

'Macintosh HD)

JUKEEOX

Macintosh™ OS X

We highly recommend that you update to Macintosh OS 10.2.4
or later. If you have Mac OS X before the 10.2 upgrade, you will find that
version 10.1 may mount the AV400 as a hard disk on your desktop, but
ONLY after a very long wait, up to 10 minutes. Version 10.0 of OS X does
not have the ability to properly recognize a mass storage device such as
the AvV400.

Macintosh™ OS X (10.2 Jaguar and 10.3 Panther)

If you have OS 10.2, you must update to version 10.2.4 or newer. This is a
o o 1046 free update from Apple® Computer. You will not require
— any special installation of software drivers or extensions.
You simply plug the AV400 into your Macintosh as
enumerated above, and within a few seconds, the AvV400
will be recognized as a mass storage device (Hard Disk)
and mount on the desktop. You can now use the Hard
disk called JUKEBOX like any other external hard disk.

‘Macintosh HD|

JUKEEOX

Windows® 98SE

You will first need to go to the Archos website (www.archos.com) to
download the driver for this old version of Windows. Go to the section
Download > Drivers and download the ‘All USB Drivers’ package. When
you first plug an AV400 into a computer running Windows™ 98SE, it will
recognize the hardware and ask to have drivers installed. Carefully follow
the instructions below. After installation of the drivers and restarting the
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computer, you will be able to drag and drops file between your computer
and the AV400 using Windows® Explorer. Be careful also to understand the
correct disconnection procedure in section 16.2. Incorrect disconnection

can cause your computer to freeze or you may loose data.

Add New Hardware Wizard

Add New Hardware Wizard

This wizard searches for new drivers for

AV-400USB2.0 Adapter

# device diiver is & software program that makes a
hardware device work

ek [0 Carcel |

“what do pou want Windows to do?

© Display st of all the diivers in a specific
Iacation, 5o pau can select the driver you want.

< Back I MNext > I

Cancel |

1. Windows 98SE has recognized a new
piece of hardware (the AV400) and
starts its wizard. Click on Next.

Add New Hardware Wizard

™ CO-ROM diive

I~ | Wierosart Windaws Wndate

I¥ Specify a ocation

[D:3Drivers =]
Browwse

< Back I Mest > I

Cancel |

3. Uncheck all of the checked boxes,
and then check the box Specify a
location. Type in the location that you
had downloaded the driver to. Click on
Next and Windows will then load the
correct drivers.

2. Click on the button Search for the
best driver. Now click on Next.

Add New Hardware Wizard

“witdows driver file search for the device:

ARCHOS AV-400 USB20 adapter

Click Back
tr continue:

“witdows is now 1eady bo install the best driver for this
device. Click Back to select a different diiver, or click Nest

Location of driver:

£ DiDrivershaRCHOS~1ATPPFR.INF

<Back [i7 Cancel |

4. Windows is now ready to install the
driver into its operating system. Click
on Next to tell Windows to install the
driver.



5. Windows will indicate when it has
L, RN W e finished copying the drivers. Click on
Finish. Do not unplug the Av400 from
sl LR the computer yet.

ardw:

Once finished, you should restart
your computer. Upon restart, it will
Carce automatically recognize the connected
device (the AV400). It will be seen
as another hard disk in Windows®
Explorer.

16.2 Disconnecting the AV400 from your Computer

WARNING: You must properly remove (unmount) your AV400 from the
computer before disconnecting the USB cable to avoid loss of data or
freezing the computer and/or the AV400.

DO NOT SIMPLY PULL OUT THE USB CABLE AT ANY TIME!

Windows®

To safely disconnect the AV400 hard disk, click on the system tray remove
icon (green arrow as shown below) and follow the instructions. Wait until
you get a message saying that you can safely unplug the device before
disconnecting the USB cable. Attention: The operating system will not
allow you to safely disconnect the Multimedia AV400 if you have an open
file from it in a running application. You will have to close all open AV400
files in any running application. Sometimes, even when files are closed
in an application, you will have to shut down the application. Using the
green disconnect arrow in the system tray will then allow you to safely
disconnect the Av400.

1. The safe remove icon is in the system tray next to the clock.

L o 't p—
e 05:24 041 PDET

Windows® XP Windows® 98SE Windows® 2000 & Windows® ME
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2. Click on the icon to eject (unmount) the AV400 from the computer and select
the ‘Safely remove’ message.

Safely remove USE Mass Storage Device - Drive(E:)

Archos JukeBox Eject

TS T

Windows® XP Windows® 98SE

3. There will be a message indicating that it is now safe to disconnect the AvV400.
You can now go ahead and unplug the USB cable from the AV400.

jr) Safe To Remove Hardware E

The 'USB Mass Storage Device' device can now be safely
removed from the system.

@ The HITACHI_ DKZ3DA 20 storage device can how be safely temoved iom the system

Windows® XP Windows® 98SE
Note: Hitachi_DK23DA-20 only indicates the type of hard disk used inside of the AV400.

Macintosh®

Drag the AV400 hard disk icon towards the trashcan,
the trashcan will become a big arrow as shown in the
screen shot to the left (Mac OS 9.x will still retain the
trashcan icon. This is OK, don’t worry.) Drop the hard
disk icon onto the arrow (or trashcan). The hard disk
icon will disappear from the desktop. You can now
safely unplug the USB cable from your AV400 and/or
computer.

JUKEBOX

« 2
=) =



SETTINGS

From the home screen, select the
options for various settings.

Setup option to reveal the menu

1]31 M 03:36 ' iJzo®10:07
¢ 4 = a4 @
Wi ET [r=iE Sound PlayMode Clock
! = G % s
& - L
[FESE Seti Display Power System
— = )
BT A B EorRHer rfis TV control
Pocket AV 400 Ver 1.1 @) ]@ ]@
17.1 Sound Settings
G If you would like to customize the sound quality, you can adjust
L | . - - .
s 'Jd the Bass, Treble, and other audio settings to suit your particular
oLun

taste. Normally you will do this while listening to music so that you
can hear the changes you make. Simply click on the LEFT function
button Setup while listening to music.

¢ Once in the Setup screen, move over
to the Sound icon and click again on
ENTER ©. Use LEFT and RIGHT to
change a parameter’s value. You will
hear these changes instantly.

e Use the UP and DOWN buttons to
select a different parameter.

¢ Click on STOP/ESC % when finished.
You will return to the Setup screen.

e Click on STOP/ESC % again and
you will return to the music playing
screen.

Sound

Built-in speaker
Yolume

Bass

Trehle

Balance

Bass Boost
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The Sound Parameters

Parameter Description

Built-in Speaker | Turns on and off the built-in speaker. Same as long press on
the center function button.

Volume 32 levels of volume (0-31).

Bass 10 levels. Decreases or Increases the low frequencies.

Treble 10 levels. Decreases or Increases the high frequencies.
Balance 10 levels. Favors the right or left channel of the Stereo signal
Bass Boost 10 levels. Increases the very low frequencies

Reset button Readjusts all settings to their default values

17.2 Play Mode Settings

i1 If you would like the AV400 to play through an entire folder of
m;ﬁ. o SONgs, play songs at random (shuffle), or any of the other playing

options, you can set these parameters in the PlayMode settings.

¢ Click on STOP/ESC % to return to the AV400 main menu and click
on Setup. Or, while listening to a song click the LEFT function button
Setup.

¢ Once in the Setup screen, move over to PlayMode and click again on
ENTER ©.

¢ Highlight one of the five PlayModes and click on ENTER © to check that
option.

e With the Repeat & Shuffle setting, choose if the songs are to be
played in order, repeated or shuffled.

e See section 3.4 for details on using the

i . Mo
ARCLibrary Py
e Picture Pause sets the amount of B
time paused between pictures in the O singe
slideshow mode. See the Photo chapter O scan

. Repeat & Shuffle Repeat ]

for more detaI|S. ARCLibrary ) Automatic ™

Picture Pause " [} ™

e . e [



Play Mode

AV400 is currently playing from a Playlist

y=

Folder: Play all tracks in the current directory

All: Play all tracks on AvV400

Single: Play a single track then stop

Queue: User can queue the next track to be played

Scan: AV400 plays first 15 seconds of each tracktt

TtQueue Mode: While the current song is playing, click on Navigate, find the next song you want
to play, then click Play. This is your queued song. You can only queue one song at a time. See the
Playlist section to prepare multiple songs to play. Once the current track is finished playing, your
queued track will be played. If you do not queue another track at this time, the AV400 will play
the next song in the directory.

t1Scan Mode: Each track in the directory is played for 15 seconds. This allows a quick sample
of each song. If you want to play the whole song, click on the Play button during those first 15
seconds. The AV400 will then revert to single directory mode and play the rest of the songs in the
directory without scanning.

6l
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Clock Settings

- The AV400 has an internal real time clock. The
s time of day is shown on the top right of the lElil?-'B
Clock  screen in either 24 hour or 12 hour display e

mode. To set it, go to Setup then select Clock.

Choose Value for
highlighted parameter

p]15804:29 |

Choose parameter

@ Clock

Hour
Minute

Time Format

When finished setting the parameters, move down to the Set button, then
click on the ENTER/GO button ©. The clock time and date are now set.
Click on the STOP/ESC button % to go back to the main settings menu.

Display Settings

7 Thesesettings regulate the interface language and the presentation

= of the screen.
Display

r]25F 02 03 ' g]z0®10:08 '

Appearance

ﬁ Display

Language

TV Standard
Video Output
LCD Brighthess

off D
archos Reflection D
D

5 [}

English D

PAL (EUROPE) D

Internal LCD D
—MD2

Interlaced D

Vrallpaper (4]
Picture name 0
Font outline (4]
Color scheme [ 4]

Previous settings

Image Display
LCD stability




Setting Description

Language

The AV400 can be set to English (default), French, or German.

TV Standard

NTSC (USA), PAL (Europe). In order to view images or
videos on an external television, select one option to send the
video signal compatible with your country’s television system.
Countries other than European or American will use one of
these two systems.

Video Output

Internal LCD or External TV. To display via the built-in LCD
screen or to view the display via an external television. Hold-
ing the LCD/TV button for three seconds will also alternate be-
tween these two options. Be sure your television is selecting the
correct external input.

LCD Brightness

0, 1, 2. The 3 brightness levels for the built-in LCD screen. Setting
to a lower value will give you a longer battery autonomy.

Image Display

Interlaced, Progressive. This is the way the video output will
be sent to the television. When viewing still images (JPEG and
BMP) on a television screen, set this to Progressive to reduce
possible flickering in the image.

LCD Stability This setting is only for some models. Use this to reduce any
LCD screen flicker you might have. Move the setting to the left
and right to get the clearest image.

Appearance Change the interface appearance

Setting Description

Wallpaper

On, Off. When set to On, the selected picture (next item) will
be displayed as the AV400 screen background.

Picture name

This option will display the names of the JPEG images in the
AV400’s System folder that can be used for screen backgrounds
(Wallpaper). You can add your own JPEG images to the System
folder by dragging and dropping a JPEG file from your computer.
You should use JPEG images with small dimensions, ideally 320
x 240 pixels (large files slow down the display).

Font Outline

If your screen background is a dark color, it will be difficult to
see the black text on the screen. Set Outlined font to On to
have a more visible white outlined font.

Color scheme

Allows you to choose what color you would like to have for the
status bar above and the screen buttons below.

Previous settings

Click this button to return to the settingss last set.

63

64

17.5 Power Settings

D~ These settings will help 15G04:3a |
= youtosavebatterypower s poyer
FOWEr  thus allowing a longer ' gaitery operation:
P Off 4] 2 mi »
battery autonomy. Bg\t':.':l'i-ght off [4 zlru“:l @
Hard drive K| 105 D]
You can set the AV400 to conserve DC-Power operation: _

. Standby 4 2 min I}
power for both modes of operation Backlight Off (4 30s ®
(when it is powered from the HEDT @ 305 ®
battery, or when it is connected
to the AC charger/adapter (DC- @& - @ .. &)

Power operation).

Parameter Description

Power Off

1-9 minutes, Never. The number of minutes of user
inactivity (no buttons pressed) before the AV400 shuts off.
During the playback of MP3 and AVI files, this setting takes
effect only after the files are finished playing.

Backlight Off

10-110 seconds, Never. The time of user inactivity (no
buttons pressed) before the AV400 turns off the screen to
conserve power. During the playback of AVI files, this setting
only takes effect once the file is finished playing.

Hard disk

10-110 seconds, Never. The number of seconds from
the time of the last file access before the AV400 tells the
internal hard disk to stop spinning. The longer this time is
set, the more often the hard disk is turning and the quicker
the response time when accessing files. However, as it is set
longer, it will quickly consume your battery. Caution: This
setting should only be changed by experienced users.

Standby

1-9 minutes, Never. The number of minutes of user
inactivity (no buttons pressed) before the AV400 goes into
Standby mode. When powered by the AC charger/adapter
(or connected to a powered TV Cradle), the Av400 will not
completely shut off. It will go into Standby mode. This way,
it can wake up to make a scheduled video recording.

A typical use of these settings is to set the power off, screen off, and hard
disk to low values when used in battery mode. When the power adapter
is plugged in, you do not need to conserve energy and thus keeping the
Power on and the Backlight on makes using the AV400 more agreeable.



Increasing the hard disk value beyond the default may actually discharge
the battery even when the Charger/adapter is plugged in. Note also that
your unit will run hotter when the backlight and hard disk are on for long
periods of time.

System Settings

(e} The System  settings allow = HELL P
Sy%i-,em you control over the low level & ::”“ —
parameters of the AV400.

Firmware Version: 0.0.13 cvs
04DMHZZBEB
Free: 16457 (MB)
Used: 2593 (MB)

Product Key:
Hard Disk

Parameter Description

Show all files Off (default), On. If set to Off, the Jukebox will only display
the file names of file types, with their corresponding icons,
that it knows how to play. If set to On, the Jukebox will
display the names of ALL the files on the hard disk (using
a ? icon for unknown types), even if they cannot be viewed
or played, such as .tif or .pdf for example. This setting
is important when inserting memory cards into the
CompactFlash™ slot. Setting it to ON will allow the Jukebox
to transfer all the files from the card media regardless of file
type. If set to OFF, it will only display file types that the Av400
is capable of playing.

Update Firmware | Used to update the AV400 to a new version of the Operating

System. See chapter 18.

Firmware Version | Displays the current version of the Operating System (OS).

Product Key Each AV400 device has a unique product key number.

Hard Disk Displays the amount of free and used space on the AV400's
hard disk. The total is less than 20,40, or 80 GB due to space
taken by formatting.

TV control

See chapter 11 VIDEO - Setting the Infrared Emitter Code for a complete
explanation of when and how to use this setting.

65

66

Updating the AV400 Firmware
Operating System (0S)

Archos periodically updates the Operating System (OS) and makes
it available for free download on the ARCHOS website (www.archos.
com). Updates to the Operating System include new features, feature
improvements, and bug fixes. You should check to make sure that you are
running the most recent version of the OS. Each time the AV400 starts
up, the OS version is displayed on the screen (example: OS Version 1.1)
on the bottom right. You will find the most recent version of the OS and
its version number at the Archos website (www.archos.com) under the
category Software.

Download the Update_AV400.AO0S file

x|  When you click on the link to
download the new OS file (the file
name is Update_AV400.A0S), your
browser may warn you that the
contents of the download may harm
your computer. This is because the
Windows® system does not know
what a .AOS file is. Be assured
that Archos has made every effort
to ensure that the file does not
contain viruses. Click on the option
Save to download this file to a convenient place, such as My Documents,
in order to later copy this file to your Av400. If your AvV400 is connected to
your PC, you can even save it directly to the Av400.

9 Some files can haim your computer. If the fils information below
{/ looks suspicious, or you do nat fully tust the source, do not open or
save this file.
File name: Update AV400,A03
File type:

Fram: i, archos, com

‘Wauld you ke to open the file or save it to pour computer?

Open 1 Save Cancel ore Info 1

W Blways ask before opening this type of file

Read the History.txt File

You will also find next to the firmware download, a text file which details the
list of changes from the previous version of the OS.

Copy to AV400 root and Update

When updating your Operating System, you must keep the AC charger/
adapter plugged into the AV400 so that it will not shut down due to low
batteries while you are performing the update. Connect your AV400 to your


www.archos
www.archos.com

LDPlayists FieFolder]  computer (section 16.1), and
Recycled Folder

Cysystem ri=roder €N cOpy the Update_AV400.
BisEnieRnelnemiten FieFoldsr  AQS file to the root directory of

)¥ideo File Falder

the AvV400. The root directory

[E update_svann.a0s is the top most level of the

e directory hierarchy. Just drag

this .AOS file onto the Av400

Hard disk in your file manager and it will place it in the top most directory

(outside any folder). If there is already an older version of the Update_

AV400.AOS file on your AV400, Windows® will ask if you want to overwrite

the current file. Click on Yes. Once this file is copied, safely disconnect
(section 16.2) the AV400 from the computer.

File Folder
1319KE A0S File

_1¥oice

| Update Firmware |

Next, go to the System parameters under Setup and then scroll down
to Update Firmware and click on it. The AV400 will search for the .AOS
file and will ask you to click Yes, to start the update. Follow the on-screen
instructions. When completed, the AV400 will restart itself and you will see
the new OS version displayed on the bottom right of the screen.
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Technical Support

e For warranty and services purposes, keep your sales receipt for proof of
purchase. The serial number for the AV420 model can be found in the
battery compartment.

e If technical support (Telephone or E-mail) determines that your product
needs to be returned, please contact the place of purchase to have your
product repaired or replaced (depending on problem type). Customers
who purchased directly from the Archos website should fill out the form
on the website under Support: Product Returns.

e There is an FAQ — Frequently Asked Questions section at the ARCHOS
Website www.archos.com, Support: FAQ that can help answer many of
your questions.

e If you need technical help, you may contact ARCHOS directly in your
own language via these phone numbers. For other countries, please
use e-mail technical support.

------------ Telephone Support--- - --

DO NOT USE PHONE SUPPORT FOR MARKETING AND
SALES QUESTIONS. These numbers are to aid those
who have technical difficulties / malfunctions.

949-609-1400 (USA, Canada) 09-1745-6224 (Spain)
0170 20 00 30 (France) 02-4827-1143 (Italy)
0207-949-0115 (UK) 020-50-40-510 (Netherlands)
069-6698-4714 (Germany)

———————————— E-mail Support

tech-support.us@archos.com
tech-support.eu@archos.com
tech-support.de@archos.com

English (United States and Canada customers)
English or French (Europe and the rest of the planet)
German (Germany)

To respond to your e-mails efficiently, when sending one, please indicate
the product name and question type in the Subject of the e-mail.

For example:
To: tech-support.us@archos.com
Subject: AV400 — Playing a Playlist


www.archos.com
mailto:tech-support.us@archos.com
mailto:tech-support.eu@archos.com
mailto:tech-support.de@archos.com
mailto:tech-support.us@archos.com

WWW.ARCHOS.COM

United States & Canada Europe & Asia

ARCHOS Technology ARCHOS S.A.

3, Goodyear - Unit A 12, rue Ampeére

Irvine, CA 92618 USA 91430 Igny

Phone: 1 949-609-1483 France

Fax: 1 949-609-1414 Phone: +33(0) 169 33 169 0
Fax: +33(0) 169 33 1699

United Kingdom Germany

ARCHOS (UK) Limited

3 Galileo Park

Mitchell Close

West Portway Andover
SP103XQ Andover

United Kingdom

Phone: +44 (0) 1264 366022
Fax: +44 (0) 1264 366626

ARCHOS Deutschland GmbH
Bredelaerstrasse 63
40474 Disseldorf

Germany
Tel: +49 211 1520 384
Fax: +49 211 1520 349

ARCHOS
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Troubleshooting

USB Connection issues

Problem: I cannot get my AvV400 to be recognized by the computer.
Solutions:

Shut off and reboot the computer and the AV400 and then try connecting
again in the preferred order mentioned in section 16.1.

Only if using Windows 98SE, you must first install the Windows98SE
drivers.

If you installed the Windows 98SE driver on your Windows® XP, 2000,
or ME edition, this could cause problems. Uninstall that driver and then
reinstall the generic Windows® Mass Storage Device driver.

If using a USB hub, try connecting without using the hub (some hubs
are not powered and may not work with the Av400).

If using a USB port in the front of your computer, try a USB port in the
back. Front USB ports are often from non-powered hubs.

Do not connect to a USB port repeated through a keyboard.

On old computers, the USB driver software on your computer may be
out of date. Find your USB chipset type by going to My Computer >
Properties > Device Driver > Universal Serial Bus (USB) Controllers >
Host Controller. You may have a chipset VIA, Intel, SIS or another. It
is possible that you do not have the latest software drivers for these
chipsets. For VIA updates, check out www.viaarena.com. For Intel
check out www.intel.com. For SIS, uninstall the driver and reinstall the
Windows default USB controller drivers.

If using a laptop computer and a docking station, try connecting
without the docking station.

If Macintosh® OS 10.1.x says it cannot mount the volume, you can use
Disk Utility to reformat the Jukebox hard disk to type MS DOS FAT32.
However, files will only be readable from a Macintosh®, not a Windows®
machine. You should update to version 10.2.4 or better.

On older computers, make sure in your system BIOS the USB port is
checked “ON" not “Off”. Usually this just happens on old machines.

On older Win98SE computers, if there is a line “lastdrive="in the
config.sys file, make sure that it is “lastdrive=z".

If the Files Allocation Table (FAT) gets corrupted, the AVv400 may not


WWW.ARCHOS.COM
www.viaarena.com
www.intel.com

show up in Windows XP for over one minute, and then it comes up as
local drive. Use DOS Utility ChkDsk as shown below.

e Windows® XP may recognize the AV400 hard disk but yet not assign a
drive letter to it. Right click on My Computer and select Manage. Then
select Storage, then Disk Management. Within this window you may
see the hard drive and be able to assign a drive letter by right-clicking
on the hard disk, and selecting the option Change drive letter and
paths...

Problem: What do I do if I try to disconnect via the green arrow but keep
getting “The device ‘Generic Volume’ cannot be stopped now. Try stopping
the device again later.”

Answer: Shut off any program that might be accessing data on the
AV400, including Windows® Explorer. If this does not work, shut down all
programs, wait 20 seconds, then try the green arrow one or two times
again. If this does not work, you should shut down the computer and
disconnect the USB cable once the computer is off.

Charging and Power issues

You do not need to fully discharge the batteries before recharging them.
Problem: You do not need to fully discharge the batteries before
recharging them.

Answer: The specifications are under the condition that the screen
backlight goes off after 30 seconds (for MP3 music) and the user does not
access the machine, it just sits and plays. If you get significantly less time
from a full charge, call our technical support hot-line.

AV400 locks up (freezes operation) or Stops

Problem: The AV400 locks-up. None of the buttons work.

Solution: If the lock buttons is set, none of the buttons respond. Hold
down the top function button for three seconds to turn off the lock buttons
function. A freeze up could also be caused by electrostatic phenomena.
That is, static electricity has temporarily knocked out the AvV400. Hold
down on the STOP/OFF % button for 15 seconds and the AV400 will shut
off. Restart it normally now.
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The Computer locks-up (freezes operation) or Stops

Problem: The computer locks-up.

Answer: Most likely because you did not use the green ‘safely remove
hardware’ icon in the system tray in order to remove the AV400 from your
computer.

File issues, corrupted data, formatting, and partitioning

Problem: On the AV400, I find new file names and folder names that I
never created or they have strange gibberish names.

Answer: Most likely, the AV400’s file allocation table (FAT) has been
corrupted. This could have been due to the AV400 shutting down (due
to low battery power) while reading or writing to your computer via the
USB connection. To fix a corrupted FAT problem, you should use the
Error Checking utility or the Check Disk utility explained at the end of this
section. Attention: Windows and Macintosh often write extra files to the
hard disk such as finder.def or System volume info. These are normal
and will not harm the Av400.

Problem: I have been using my AV400 to transfer files back and forth
between different computers. Will defragmenting the AV400 hard disk do
any harm to it?

Answer: Defragmenting the AV400 hard disk may be useful after having
transferred many files to and from the AV400. It is never harmful to use
the defragmenter on the Av400. Make sure no other program is running
while using the Windows® defragmenter utility. Make sure you power the
AV400 with the external power adapter during this procedure.

Problem: I have copied files to my AV400 via USB from my computer, but
now I cannot see these files on the device.

Answer: You have probably transferred a file which the Av400 cannot
play, for example a PDF, MOV, or DOC file. Go to the System Settings
under Setup on the main screen and you will find a parameter called Show
all files. If you set it to on, the AV400 will show all files, even if it cannot
play the file (you must browse via the browser mode from the main menu
screen). The browser will show a ? icon indicating that it is not one of the
standard file types that it can play.



Problem: I want to reformat the AV400's hard disk.

Answer: You can do this, but it will erase ALL of the data on your AV400.
Sometimes this may be necessary if your FAT (File Allocation Table)
becomes so corrupted that nothing seems to fix your file problems. First,
as explained below, you should run ScanDisk or the DOS chkdsk (Check
Disk) program to try to fix your problem. If this doesn't fix your problem
and you are sure you must reformat the AV400 hard disk, then go to the
screen Setup > System and press and hold the Right function button
for three seconds. A button “Format HD” will appear. Use this button to
format the AV400's hard drive. Remember, doing this will erase all the
data on the hard disk!!!

Problem: I would like to partition the AVv400 hard disk.

Answer: If you know how to partition a hard disk, this is OK. The AV400
will, however, only recognize a FAT32 partition. Thus it will just see and
use that partition of the hard disk which is a FAT32 partition.

Problem: My files have disappeared from the AV400.

Answer: To see all your files, make sure the setting Show all files is set
to ON. Also make sure that you browse your files via the Browser mode
and not a filtered view such as Photo, Music, or Video.

Windows® 98SE & ME Running Scan-Disk (Error Checking)

Quit all running applications.

Properly connect the AV400 to your computer as explained in chapter 16.
Make sure external AC adapter is powering the AvV400.

Right click on the Av400 hard disk in Windows® Explorer and select
Properties.

Select the Tools option and run the Error checking program

e Make sure you check the box to automatically fix errors.

¢ Be patient, this may take a while. Windows® may ask you to restart the
computer to make certain Windows files available. This is OK, click on Yes.

Windows® XP & 2000 Running Check Disk Utility (ChkDsk)

If you still have problems with the file system on your AV400 you can try
to fix it using the DOS utility, check disk (chkdsk). Do the following;

¢ Make sure external AC adapter is powering the AV400.

e Quit all running applications.

¢ Properly connect the AV400 to your computer as explained in chapter 16.
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Wait patiently (up to 5 minutes) for Windows XP to show the local drive
as mounted.

Open a DOS window. Programs > Accessories > Command Prompt.

At the prompt, type chkdsk e: /f. Use e: or f: or whatever drive letter is
representing your AV400. The /f argument tells the program to automatically
fix errors.

Be patient, this may take a while.

When it is finished, exit the DOS Window and properly disconnect the
AV400 from your computer.



Technical Specifications

ARCHOS VIDEO AV400 series

Storage Capacity

Model AV4xx : xx = Size of Hard Drive in Gigabytes*

Computer Interface

High Speed USB 2.0 (compatible USB 1.1)

Image Playback

JPG and BMP (4, 8, 24 bit) images, any size

Audio Playback

Stereo MP3 decoding 30-320 kb/s CBR & VBR, WMA, WAV.

Audio Recording

Stereo WAV (PCM & ADPCM)

Video Playback

Video track: MPEG-4 Simple Profile compliant .AVI format (DivX™**
4.0 & 5.0 & XviD) 720 x 576 pixels @ 25fps maximum.
Sound track: MP3 or WAV IMA-ADPCM stereo sound tracks

Screen Depending on model, either a 3.5 or 3.8 inch color TFT LCD (QVGA)
320x240 pixels 262 thousand colors
Television Video output in PAL (EU) or NTSC (US) standard
Playback Autonomy*** | Model 420: Up to 12 hours MP3, up to 4 hours video
Models 440/480: Up to 16 hrs music, up to 4 %2 hrs video
Scalability Free Operating System updates downloadable from ARCHOS website
Ports CompactFlash™ slot to read CompactFlash™ type 1 memory cards

AV Connections

Audio/video Multi-connect jack. Includes connections for audio/video
IN and audio/video OUT.

Power source

Model 420: Removable Lithium-Ion battery pack.
Models 440, 480: Non-removable internal Lithium-Ion battery pack.
All models come with an external charger/adapter.

Physical Dimensions

Model 420: 127 x 82 x 21 mm (5.0 x 3.2 x .83 inches) - 274 grams
Models 440, 480: 127 x 82 x 27 mm (5.0 x 3.2 x 1.1 inches) - 315 grams

Temperature Range

5 °C to 35 °C running ; -20 °C to 45 °C storage

System Requirements

PC: Windows 98SE, ME, 2000, XP Pentium II 266MHz with 64MB ram
Mac: 0S 9.2 or X (10.2.4), iMac, G3 or higher

*1 GB =1 billion bytes, formatted capacity is less.
**DivX is a trademark of DivXNetworks, Inc.
***Depending on usage (stop/start/writing)
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Legal

Warranty and Limited Liability

This product is sold with a limited warranty and specific remedies are available to the
original purchaser in the event the product fails to conform to the limited warranty.
Manufacturer’s liability may be further limited in accordance with its sales contract.

In general, the manufacturer shall not be responsible for product damages caused
by natural disasters, fire, static discharge, misuse, abuse, neglect, improper handling
or installation, unauthorized repair, alteration or accident. In no event shall the
manufacturer be liable for loss of data stored on disk media.

MANUFACTURER SHALL NOT BE LIABLE FOR ANY SPECIAL, INCIDENTAL
OR CONSEQUENTIAL DAMAGES. EVEN IF INFORMED OF THE POSSIBILITY
THEREOF IN ADVANCE.

ARCHOS licensor(s) makes no warranties, express or implied, including,
without limitation, the implied warranties of merchantability and fitness
for a particular purpose, regarding the licensed materials. ARCHOS’s
licensor(s) does not warrant, guarantee or make any representations
regarding the use or the results of the use of the licensed materials in
terms of its correctness, accuracy, reliability, correctness or otherwise.
The entire risk as to the results and performance of the licensed materials
is assumed by you. The exclusion of implied warranties is not permitted by
some jurisdictions. The above exclusion may not apply to you.

In no event will ARCHOS's licensor(s), and their directors, officers,
employees or agents (collectively ARCHOS' licensor) be liable to you for
any consequential, incidental or indirect damages (including damages
for loss of business profits, business interruption, loss of business
information, and the like) arising out of the use of inability to use the
licensed materials even if ARCHOS' licensor has been advised of the
possibility of such damages. Because some jurisdiction do not allow the
exclusion or limitation of liability for consequential or incidental damages,
the above limitations may not apply to you.

Please see your sales contract for a complete statement of warranty rights, remedies
and limitation of liability.

Furthermore, warranty does not apply to:

1. Damages or problems resulting from misuse, abuse, accident, alteration
or incorrect electrical current or voltage.

Any product tampered-with or damaged warranty seal or serial number label.
Any product without a warranty or serial number label.

Batteries and any consumable items delivered with or in the equipment.

PWN



Warnings and Safety Instructions

CAUTION
To prevent risks of electric shock, this unit must only be opened by qualified service personnel.
Power off and disconnect the power supply cable before opening the unit.

WARNING

To prevent fire or shock hazard, do not expose the unit to rain or moisture.

Use of this product is for personal use only. Copying CDs or loading music, video,
or picture files for sale or other business purposes is or may be a violation of
copyright law. Copyrighted materials, works of art, and/or presentations may require
authorization to be fully or partially recorded. Please be aware of all such applicable
laws concerning the recording and use of such for your country and jurisdiction.

FCC Compliance Statement

FCC Compliance

This equipment has been tested and found to comply with limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference
to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

¢ Reorient or relocate the receiving antenna.
¢ Increase the separation between the equipment and receiver.

¢ Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

¢ Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Modifications not authorized by the manufacturer may void users
authority to operate this device.

FCC Part 15 - Operation is subject to the following two conditions:

1. This device may not cause harmful interference;

2. This device must accept any interference received including interference that may
cause undesired operation.

Electrostatic Discharge

Note: During electrostatic discharge, the product may be malfunctioning. Reset to
return normal operation. The AV400 reset is actuated by pressing and holding the
STOP/ESC button for 10 seconds. The unit will power off. Restart normally.
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Copyright Notice

Copyright ARCHOS © 2003 All rights reserved.

This document may not, in whole or part, be copied, photocopied, reproduced,
translated or reduced to any electronic medium or machine-readable form without
prior consent, in writing, from ARCHOS. All brands and products names are registered
trademarks and the property of their respective owners. Specifications are subject to
change without notification. Errors and omissions accepted. Images and illustrations
may not always match contents. Copyright ® ARCHOS. All rights reserved.

Disclaimer of warranty: to the extent allowed by applicable law, representations and warranties
of non-infringement of copyrights or other intellectual property rights resulting from the use of the
product under conditions other than as here above specified, are hereby excluded.

LCD Pixel Policy

The LCD screen on your Archos AV400 unit has been manufactured to rigorous
standards to provide a high quality viewing experience. Nevertheless, your LCD
screen may have slight imperfections. This is not particular to the Archos screen,
but to all devices which have LCD screens regardless of the original manufacturer of
the LCD. Each product vendor guarantees that his screen will contain no more than
a certain number of defective pixels. Each screen pixel contains three dot elements
(Red, Blue, and Green). One or all of the dots in a given pixel may be stuck on or
stuck off. A single dot stuck off is the least noticeable. All three dots of a pixel stuck
on is the most noticeable. Archos guarantees that its AV400 screen will have no
more than 1 defective pixel (regardless if that pixel has one or more defective dots).
This means that during the period of guarantee for your country or jurisdiction, if
the screen on your product has two or more defective pixels, Archos will repair or
replace your AV400 product at its cost. Thus, one defective pixel is not grounds for
replacement or repair of the product.

Avoiding Hearing Damage

This product respects the current regulations for limiting the output volume of
consumer audio devices to a safe level. By listening to your device with headphones
or earbuds at high volumes, you run the risk of permanent damage to your ears.
Even if you get used to listening at high volumes and it seems normal to you, you
still risk the possibility of damaging your hearing. Reduce the volume of your device
to a reasonable level to avoid permanent hearing damage. If you hear ringing in your
ears, reduce the volume or shut off your device. This device has been tested with the
Archos supplied earphones. Other manufactures earphones may produces volume
levels higher or lower than the Archos delivered earphones.



